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What's New in EasyWorship 2009

Display Foldback (Stage Display)
l Send Lyrics and Scripture content to stagemonitors (automatically synced with audience output)
l Send Alerts and custommessages to stagemonitors (only seen on stage)
l ClockDisplay shows the current time
l Lyric Display, optional verse/chorus tags, shows first line of next slide, automatic word wrap, andmore
l PowerPoint Display shows current and next PowerPoint slides
l Full control of format and style, including: text/font styles, custom background, scrolling or static alerts, andmore
(requires additional hardware)

VJ (Video Jockey) Mode
l Live background switching (with transitions)
l Switch between Videos, Images, Feeds and Slide Backgrounds

Audio Integration
l Add audio files directly to the Schedule
l Add audio files as backgrounds to Songs or Scripture

Web Display
l Easily enter URLs to display web pages
l Integrated navigation controls (home, back, next, refresh, stop)
l Full support for YouTube videos, andmore
l Full support for Flash-based content

Integrated Media Store
l Easily browse thousands of popular Mini Movies, Motions, Countdowns and Stills
l Preview media directly in EasyWorship
l Integrated Downloads, automatically puts your new media where it should be (no need tomanually find and install
downloadedmedia)

l Purchase and install bibles fromwithin EasyWorship

Updated User Interface
l Updated buttons and icons throughout
l Redesignedmedia player and interface controls for video, DVD and feeds
l Redesigned resource area and display options (preferences) area
l Theme aware so the look automatically customizes for WindowsXP, Vista or 7
l Redesigned control header (top bar) and pane dividers to optimize workspace
l Redesigned to work with varying screen DPIs (large fonts)



How it Works

Schedule Area:
The Schedule Area contains selected items for a presentation. Drag and drop the items you want to use in your present-

ation into the Schedule Area. Youmay also add PowerPoint slide shows to your schedule by clicking the on the right
side of the Schedule Area. Use the arrow keys on the right side toolbar to move items around in the schedule. You can
also drag items around in the schedule. Schedules can be saved for future use.

Presentation Work Flow:
The presentation flows from the left column (Schedule Area) through the center column (Preview Area) to the right
column (Live Area). Clicking Go Live sends the current item selected to the Preview Area to the Live Area and to the
screen. The next item in the schedule is automatically selected and shown in the Preview Area. When you are finished dis-
playing the current item in the Live Area pressGo Live again to display the next item in the schedule.

Resource Area:
The Resource Area provides access to songs, scriptures, media, and online content.

Song Tab: Displays the song database.
Scripture Tab: Displays the scripture database with version option tabs at the bottom.



Media Tab: Displays the Video, Images, Feeds, DVD and Audio tabs. You can double-click on an item to project it
immediately or you can place songs, scriptures, andmedia into the schedule to create an ordered service.
Online Tab: EasyWorship has the ability to interact with the web. Click the Online tab to unlock the web features in
EasyWorship.

Downloaded Items: The downloaded items area will be blank until media or bibles have been downloaded
from theMedia Store tab.

Media Store: TheMedia Store tab allows you to purchase and downloadmedia and bibles for use in
EasyWorship. Themedia or bibles are downloaded directly into EasyWorship.

SongSelect: The SongSelect tab allows you to import songs directly into the songs database from
SongSelect. (CCLI SongSelect subscription required.)

Web: TheWeb tab allowsweb pages to be added to the schedule. YouTube videos can be streamed in full
screenmode directly from the web. This feature also allows for playback of SWF files. See Playing Flash Con-
tent

Preview Area:
The Preview Area shows the item that is currently selected either in the Resource Area or in the Schedule Area. Tomove
the contents to the Live Output Area and display it to the congregation go to the Preview Area and double-click on the
highlighted item or clickGo Live .



Live Output Area:
The Live Output Area displayswhat is currently being projected on the screen. You can navigate the contents and choose
verses to keep up with the speaker using themouse or arrow keys.

Video Jockey Mode: Video Jockey or VJmode is enabled by clicking the drop down button at the top right of the
Live Area. This is a feature that allows you to quickly change backgrounds on the fly, by just clicking on the video,
image, feed or background you wish to use.



Training Videos
Videos are available online to help you get started using EasyWorship. Visit http://youtube.com/easyworshipsoftware to
view the videos. An internet connection is required to view these videos.

http://youtube.com/easyworshipsoftware


Activating and Registering EasyWorship

When EasyWorship is purchased, you will receive an email with registration information in it or youmay receive a CD with
a Product Key attached. Follow the instructions below to register EasyWorship.

Register EasyWorship without a Product Key:
If you purchased EasyWorship and did not receive product keywith the CD, check your email for a registration email, or
check the envelope you received the disk in for a registration letter. Enter the registration information you received using
the steps under Registering EasyWorship.

Activate EasyWorship using a Product Key:

If you receive this card with your EasyWorship CD, there are two ways to register EasyWorship using a Product Key, by
phone or online activation.

1. Call (918) 250-1493 9AM - 6PM (CST) to activate by phone.
Visit EasyWorship.com/activate to activate online.

2. After activating via phone or online, check your email for a registration email.
3. Enter the registration information you received into EasyWorship using the steps under Registering EasyWorship.

Registering EasyWorship:
1. Open EasyWorship.
2. In the About EasyWorship dialog box, click Register.
3. In the Register dialog box, type the registration information in the appropriate boxes.

l All of the registration informationmust be entered exactly as it appears in the registration letter.

http://www.easyworship.com/activate


4. Click Validate. (The registration fields will gray out)
5. Click Continue or Close to complete the registration.

-Or-

With EasyWorship Open:

1. Click on the Helpmenu, click Register Products.
2. In the Register dialog box, type your registration information in the appropriate boxes.

l All of the registration informationmust be entered exactly as it appears.
3. Click Validate. (The registration fields will gray out)
4. Click Close to complete the registration.

If you have any problems, see Incorrect Serial Number!. Youmay also call us at +1-918-250-1493 or e-mail us at sup-
port@easyworship.com.

mailto:support@easyworship.com
mailto:support@easyworship.com


Incorrect Serial Number!

This error can occur for a couple of reasons:

1. EasyWorship has already been registered.
l If EasyWorship is upgraded from an older version that was already registered, there is no need to enter your
serial number. This error will appear if the same registration code is entered again.

l To determine if EasyWorship is already registered, click on the Help menu then About EasyWorship. If the
church name and serial number are in the registration area at the bottom, the software is already registered.

2. Your EasyWorship registration information has not been entered exactly as it appears on your registration letter.

l Verify that the registration information has been entered exactly as it is on the registration letter. The church name,
phone number, serial number are all case and space sensitive.



l The serial number has to be entered with the dashes included.
l The phone number should be entered exactly as it is in the letter or email that you received when the software was
purchased.

If you continue to receive this error message call us at +1-918-250-1493 or email us at support@easyworship.com.

mailto:support@easyworship.com


Running EasyWorship For The First Time

When launching EasyWorship for the first time, a prompt will appear to install the demo data that comeswith EasyWor-
ship.
The demo data is not required for EasyWorship to operate. The demo datamay be installed or uninstalled. See Adding
and Removing DemoSongs. Use the instructions below to install them upon running EasyWorship for the first time.

1. When opening EasyWorship the first time the
Add/Remove Demo Data window will appear.

2. Select "Install songs from GreatWor-
shipSongs.com", To install the 100+ classic and
contemporary songs fromGreatWor-
shipSongs.com.

3. Click Next.

Note:No internet connection is required to install
these songs.

4. Select "Install default songs and backgrounds
from EasyWorship", to install the default back-
grounds and songs fromEasyWorship.

5. Click Next.



6. Click Back to change the previous selections or
click Finish to proceed with installation of the
EasyWorship demo data.

l A window will now appear with a sum-
mary of the choices selected.



Dual Monitor / Projector Setup
If you are using a laptop computer, see Laptop Setup

Enabling Windows Extended Desktop:

Windows 7:
1. Hold down theWindows key on the keyboard and press P.
2. Use your mouse to select Extend.

Windows XP, Vista & 7:
1. Right-click on theWindowsDesktop.
2. Select:

Windows XP: Properties, then Settings tab.
Windows Vista: Personalize then Display Settings link.
Windows 7: Screen Resolution



Notes
If Display 1 and 2 boxes do not appear, your computer does not have dualmonitor capability, or you do not have a pro-
jector or monitor plugged into the secondary video output on the computer.

3. Select Monitor 2.

4. Select Extend my Windows Desktop onto this monitor or select Extend these displays from the drop down list..

5. Set the screen area resolution.
Standard 4:3 -800 X 600 or 1024 X 768
Widescreen 16:9 -852x480, 1280x720 or 1920x1080
Widescreen 16:10 - 1280x768, 1280x800 or 1440x900

6. Verify the color setting for Monitor 2 is set to 32 bit.



7. Click Apply thenOK. If prompted to keep the settings click yes.
8. Open EasyWorship.
9. Follow the instructions below to setup EasyWorship to use your secondmonitor.

Setting EasyWorship to use your second monitor:
1. Click on the Livemenu.
2. ClickOptions.

3. Under General, go to Select Output Monitor and select Secondary Monitor from the drop down list.
4. Make sure the Enable DirectX Support check box is checked.
5. ClickOK.

See DualMonitor Troubleshooting if you are having problemswith your dualmonitor setup.
See Can I Run EasyWorship in SingleMonitor Mode? for more information about running EasyWorship if your computer
isn't able to support dualmonitors.



Display Foldback

Display Foldback allows EasyWorship to take advantage of a third video output to display content for stagemonitors. Addi-
tional hardware is required to use this feature. TheMatroxDualHead2Go box is recommended for this feature. See Dis-
play FoldbackMonitor Setup and FoldbackHardware

Foldback Features:

l Send Lyrics and Scripture content to stagemonitors (automatically synced with audience output)
l Send Alerts and custommessages to stagemonitors (only seen on stage)
l ClockDisplay shows the current time
l Lyric Display, optional verse/chorus tags, shows first line of next slide, automatic word wrap, andmore
l PowerPoint Display shows current and next PowerPoint slides
l Full control of format and style, including: text/font styles, custom background (not just black), scrolling or static
alerts, andmore (requires additional hardware)

SeeMonitor Options, Songs Text, Scripture Text, PowerPoint Options, and Alerts and Time



Installing Sample Media
When you purchase EasyWorship 2009 you have access to pre-selected freemedia that can be downloaded through the
Media Store within EasyWorship. Follow the instructions below to download the samplemedia that comeswith EasyWor-
ship 2009.

1. Open EasyWorship.
2. Click theOnline tab.
3. On theMedia Store tab click Login.
4. At theAccount Login screen enter your email address and password, then clickLogin.
5. TheMy Downloads page will appear.
6. Click theWMV button next to each video and the JPG button next to each image.
7. The download progresswill appear in theStore Downloads area to the left.
8. After eachmedia file has downloaded, you can find it under theMedia tab.

Notes:
l When logging in, use the email address and password you used when you purchased the software. If you pur-
chased over the phone or through one of our dealers, select First Time Here. Enter your email address and click
Proceed. The email address you use when creating amedia store account must also be listed as a contact on the
account that purchased EasyWorship in order to access the samplemedia.

l Youmay email support@easyworship.com if you need help with your account.
l Media files are downloaded to the EasyWorship profile you are currently using. The default download location is:

XP - C:\Documents and Settings\All Users\Shared Documents\Softouch\EasyWorship\Default\Resources
Vista - 7 - C:\Users\Public\Public Documents\Softouch\EasyWorship\Default\Resources

SeeAdding Backgrounds if you would like to use free samplemedia for backgrounds.

mailto:support@easyworship.com


Adding More Bible Versions

EasyWorship offersmany free and copyrighted bibles. Bibles can be purchased via theMedia Store tab or by calling us at
+1-918-250-1493. If EasyWorship was purchased via a dealer please contact them to purchase. After the bible is pur-
chased, we will send a new serial number to you via e-mail.

Purchasing a Bible:

1. Open EasyWorship, click the Online tab.
2. Click Login at the top right of theMedia Store page, then log in to the EasyWorshipMedia Store.
3. Click the Bibles tab at the top of the page.
4. Click Add to Cart next to any bibles you wish to purchase.

Clicking Download will download and install the bible text, but the bible will not appear as a tab under the Scriptures
tab unless it is a free bible. Purchased bibles have to be activated with a serial number.

5. Click on Proceed to checkout in the cart.

6. After checking out, the bibles you purchased be activated in EasyWorship on this computer.
7. Check your email for the new serial number that will activate the bible on any other computers youmay have.

Activating A Purchased Bible:

1. Open EasyWorship.
2. Click the Help menu.
3. Select Register Products.
3. In the Serial Number field type in the new serial number.
4. Click Validate.



5. The Validate button will gray out.
6. Click Close.
7. Click on the Scriptures tab.
8. The tab for your new bible will show up at the bottom of the Scriptures Area.
9. If themessage This version of the bible is not installed appears, click download and install it now.
l If you do not have an internet connection, youmay download the text from our web site onto a computer that has
internet access and install the bible text manually. See Installing Bible Text Manually

Installing Bible Text Using the Media Store:

1. Click on theOnline tab in the Resource Area.
2. Click theMedia Store tab.
3. Click on Bibles.
4. Click Download next to the scripture you wish to install.
5. The scripture will download and install automatically.
l If you haven't purchased the scripture yet, click Add To Cart and go through the checkout process.

Installing Bible Text Manually:
1. At a computer with internet connection, browse to

http://www.easyworship.com/bibles.
2. Click on the download link for the bible you want to

download.
3. Save the file to a disk.
4. Take the disk to the computer you want to install

the bible on.
5. Click the Scriptures tab.
6. Click the button to the right of the bible ver-

sion tabs.
7. Click Install Bibles From Disk.

http://www.easyworship.com/bibles


8. Browse to and select the bible file
you saved to the disk.

9. ClickOpen.
10. Follow the steps under Activ-

ating A Purchased Bible from
above.

11. The scripture text will now
appear.



Using PowerPoint 2007 / 2010 Files

Installing PowerPoint Viewer 2010:

Upon the first attempt to use a PowerPoint 2007 or 2010 file, EasyWorship will prompt you to download PowerPoint
Viewer 2010 onto your computer. This will only occur if you do not have Microsoft PowerPoint 2010 Viewer or Microsoft
PowerPoint 2007 / 2010 installed.

1. Click the download.
2. Click the download on the web page that appears.
3. Click Save on the window that appears.
4. Browse to your Desktop and click Save.
5. After the file has downloaded. Open the file and follow theWizard to install PowerPoint Viewer 2010.

Notes
Youmay also start the download of the PowerPoint Viewer by clicking on Help >Install Microsoft PowerPoint Viewer.
Visit www.easyworship.com/support/ and enter PowerPoint in the search bar for related articles.

http://www.microsoft.com/downloads/details.aspx?FamilyID=cb9bf144-1076-4615-9951-294eeb832823&displaylang=en
http://www.easyworship.com/support/kb


Codecs Explained

What is a codec?
Codec - (enCOder/DECoder or COmpressor/DECompressor) - software (or hardware) that compresses and decom-
presses audio and video data streams.

The purpose of codecs is to reduce the size of digital audio samples and video frames in order to speed up transmission
and save storage space.

l For more information go to http://www.free-codecs.com/guides/What_you_need_to_know_about_codecs.htm

When you play a video or sound file through EasyWorship, it has to know how to decode that file. A codec is a piece of soft-
ware that tells EasyWorship how to decode the video or audio file. If you don't have the proper codec installed on your com-
puter, EasyWorship won't be able to play your multi-media file.

l Standard codecs that are included automatically inWindowsMedia Player are :
Video: Mpeg1, AVI, WMV
Audio: MP3,WAV,WMA
EasyWorship can use any of these types of files without installing extra codec software.

l EasyWorship can playmany other types of files as long as you have a codec for EasyWorship to decode the file with.
Mpeg2, Mpeg4, Divx, Mov files require extra codec software.

l Avoid downloading codec packs that claim to have a codec for every type of file. Many times theywill install software
that conflicts with EasyWorship and can cause your media files to play incorrectly. The only codec packwe current
recommend is the K-Lite codec pack. See K-Lite Codec Pack.

l We recommend FFDShow, Gabest, DScaler or PowerDVD6 or 7 codecs for playingMpg2 files and DVDs. See
RecommendedDVD &Mpg2Decoders

http://www.free-codecs.com/guides/What_you_need_to_know_about_codecs.htm
https://support.easyworship.com/support/solutions/articles/6000015276-k-lite-codec-pack-play-mov-mp4-and-flv-files-ew-2009-


Online Content

EasyWorship allows you to schedule online content to be displayed during a presentation. Clicking theOnline tab in the
Resource Area unlocks EasyWorship's online options.When clicking theOnline tab, you will notice that the Preview and
Live Areas are now replaced with a web browser with three tabs at the top left. TheMedia Store tab allows you to pur-
chase and downloadmedia and bibles directly to EasyWorship. The SongSelect tab allows you to import lyrics via the
SongSelect lyric service. This allows you to keep SongSelect open and available at all times for quick access. TheWeb
tab allows you to add web sites to the schedule to be displayed during a presentation. TheWeb tab also allows you to
schedule Flash content and YouTube videos.

SeeMedia Store Tab, SongSelect Tab, and Web Tab for more information.



System Requirements for Desktop & Laptop Computers

See SystemRequirements on EasyWorship.com for the latest information.

EasyWorship is compatible withWindows 98, SE, ME, 2000, XP and Vista, and will run onmost computers that meet the
requirements for those operating systems. And since EasyWorship is a dual output system, you'll need a dual output card
for displaying the control screen separately from the live presentation output.

You don’t need a fast computer to take advantage of the basic features EasyWorship has to offer. However, if you want to
display text over moving backgroundswith video transitions or if you’re looking to display HD content, pay close attention to
these requirements.

The following are the preferred computer requirements for EasyWorship:

Basic Requirements
Keeping it simple? Here’s what you need to display songs and Scriptures over still backgrounds and to run PowerPoint
slideshows

l Processor: 500MHzPentium II Processor
l RAM:Win XP - 512MB ;Win Vista / 7 - 1GB
l Hard Drive: 100MB free disk space
l Dual output video card
l CD-ROMDrive

Standard Requirements
Here’s what you need to play DVDs and display text over video with smooth transitions.

l Processor: 1.7 GHzPentium 4 , 1.6 GhzCore2Duo
l RAM:Win XP - 1GB ;Win Vista / 7 - 2 GB
l Hard Drive: 7200 RPMhard drive, 500MB free disk space
l Dual output video card with 128MB videomemory
l Available DVD drive and recommended codecs

HD Requirements
l Processor: 2.8 GHz Intel Core2Duo, Core2Quad or 2.66GHz I5, I7
l RAM:Win Xp - 2 GB ; Vista / 7 - 3 GB
l Hard Drive: SATA 7200 RPMHard Drive with 8MB cache, 500MB of free disk space
l NVIDIA G-Force 9800GT, GTS 250, 450, 460, 550, 560 or ATI/AMD Radeon HD 4850, 5850 or 6850
l Available DVD drive and recommended codecs

Video Cards
Video cards should be purchased with either an AGP or PCI Express interface. Standard PCI video cardswill work, but
you will be unable to do quality video transitions and high definition video.

Laptops
Laptop computers shouldmeet the same requirements of a Desktop computer. Verify with your laptopmanufacturer that
the video card can support WindowsExtended Desktop and not just clone what is on your laptop display. Most late model
laptopswith NVIDIA, ATI or Intel graphics cardswill have this ability. If you only have onemonitor connection on your

http://www.easyworship.com/easyworship/techspecs#SystemRequirements
https://support.easyworship.com/support/solutions/articles/6000015276-k-lite-codec-pack-play-mov-mp4-and-flv-files-ew-2009-
https://support.easyworship.com/support/solutions/articles/6000015276-k-lite-codec-pack-play-mov-mp4-and-flv-files-ew-2009-


laptop, your laptop display will be your primary output (operator screen) and your projector will be your secondary output
(live screen).

See DualMonitors Explained and Laptop Setup for more info on setting up a laptop for dual video output.
See Computer Requirements Unsupported for more information about unsupported hardware.



More Video Card info

l PCIExpress is faster, and slightlymore expensive than PCI.
l There are different levels of PCI Express, referred to as x1(by 1), x4(by 4), x8(by 8) and x16(by 16).
l PCI Express slots are usually black, PCI slots are usually white and if you have an older system, AGP slots are usu-
ally brown in color. Note that somemotherboardsmay vary in color.

l PCI Express x16 is the fastest technology.
o Choose PCI Express over AGP for speed if you have the option.
o Choose AGP or PCI Express over Standard PCI if you have the option.
o Standard PCI is the slowest option. It will work, but you will not have the best performance.

l See picture below to determine which slot(s) you have available on your motherboard keeping inmind that your exist-
ing video card is normally removed so that slot may be available, too, and youmay havemore than one of each. To
do this you will have to pop the cover off of your PC to get a look at your motherboard.

l We recommend using a Single PCI Express or AGP video card with two video outputs over using two video cards
with single outputs. Thismakes setupmuch easier.

The slots that you have available will determine which video card(s) you can use.

l All graphics cardsmust support DirectX in order to use all of the functions of EasyWorship.
l Download the latest versions of drivers for any new hardware device from themanufacturer's website after you
install it.

l Many new computers will comewith a less powerful graphics card already installed. In some cases, these cards do
not handle our multimedia requirements well. Many times they only have the ability to display output on onemonitor.

l We recommend nVidia graphics cards. They have proven to be the least problematic for EasyWorship customers
and they provide the best performance for what we do.



l Many of the ATI, Via S3 and SIS cardswork. However, when trying to use the DVD editor, some of them have
caused an ActiveMovie window to appear. This renders the DVD editor unusable. See ActiveMovieWindow Over
DVD Editor for more info.

l When shopping for a graphics card, avoid nVidia GeForce Cardswith amodel number ending in LE or Turbo
Cache.

l Cardswith LE in the name are scaled down versions of a higher end graphics card, andmay not performwell.
l Turbo Cache is a new feature on nVidia video cards, that allows the video card to share the systemmemory. These
types of cards don't perform aswell. Many of these cards do not allow EasyWorship enoughmemory to enable Dir-
ectX support.

l ATI has a feature like the Turbo Cache feature on the nVidia cards. It is called Hyper-memory. Youmay see the
same results with these cards.



Unsupported Hardware

See SystemRequirements on EasyWorship.com for the latest information.

Unsupported Processors:
Intel Celeron
AMD Duron
AMD Sempron

Explanation:
Processors such as the Intel Celeron, AMD Duron and Sempron processors were designed for office use. Theywork well
for that type of environment, but not as well for multimedia. We recommend a processor that is designed to handlemul-
timedia aswell as office needs.

Unsupported Video Cards:
ATI Radeon 7000
ATI Radeon 7500
ATI Radeon 9250
SomeATI Radeon x600
Older nVidia Quadro
GeForce Cards with Turbo Cache
All SIS
All Matrox except TrippleHead2Go and DualHead2Go
Any video card with less than 64MB video ram
Single output video cards
USB video cards
Wireless Video cards
Mobile ATI graphics in Laptops (Driver crasheswhen using extended Desktop)

Explanation:
Unsupported video cards are cards that we have found to be either problematic, do not utilize DirectX well or are not able
to utilizeWindowsExtended Desktop.

SeeMore Video Card info

http://www.easyworship.com/easyworship/techspecs#SystemRequirements


Recommended Video Capture Cards

See SystemRequirements on EasyWorship.com for the latest information.

Recommended Capture Cards

5 Volt PCI:
l KWORLD X-Pert DVD Maker PCI Card VS-L883D (64/32 bit compatible)
l ViewCast Osprey 100 found at viewcast.com (Vista Compatible using XP Drivers)
l ADSTech Instant Video PCI (PTV-390) (Vista Compatible)
l AverMedia DVD EZMaker PCI
l KWORLD DV/AV 883 (64/32 bit compatible)

Universal PCI:
l ViewCast Osprey 230 found at viewcast.com (Vista Compatible using XP Drivers)

PCI E X1:
l KWORLD PlusTV PVRTV-PE360-A (64/32 bit compatible)

USB:
l KWorld DVDMaker USB 2.0 (64/32 bit compatible)
l KWORLD DVD Maker USB 2.0 VS-USB2800 (64/32 bit compatible)

See SystemRequirements on EasyWorship.com for the latest information.

Notes:
Youmay need to set your capture card to use a 320x240 or 640x480 capture resolution for best performance. SeeWork-
ing with Feeds

http://www.easyworship.com/easyworship/techspecs#SystemRequirements
http://www.easyworship.com/easyworship/techspecs#SystemRequirements


Display Foldback Hardware

There aremultiple ways to configure your computer hardware to support a third monitor for display foldback. See the dif-
ferent options below.

Option 1: Matrox DualHead2Go

TheDualHead2Go comes in three editions. Analog, Digital and DP. We only recommend either the Analog or Digital Edi-
tions. The DP edition is only for use with Display Port monitors.

The Analog Edition is the cheapest of the three and only has VGA connections. It has amaximum resolution of 2 x 1280 x
1024.

l 4:3 resolutions for EasyWorship with this box are 2 x 800x600 or 2 x 1024x768
l 16:9 resolution for EasyWorship with this box is 2 x 1280 x 720.

The Digital Edition has two DVI outputs. It has amaximum resolution of 2 x 1920 x 1200.

l 4:3 resolutions for EasyWorship with this box are 2 x 800x600, 2 x 1024x768, 2 x 1280x1024.
l 16:9 resolutions for EasyWorship with this box are 2 x 1280 x 720 and 2 x 1920x1080

Notes
If you need to use independent resolutions for the foldback and front of house screens, you'll probably want use option 2 or
3.

See FoldbackMonitor Setup for help setting up EasyWorship to work with this device.
See Display FoldbackHardware for help purchasing the DualHead2Go.

Option 2: ATI / AMD RADEON HD 5850/5870 & 6850/6870 With Eyefinity

The ATI / AMD RADEON HD 5850/5870 & 6850/6870 cards have four video outputs; three can be used simultaneously;
2 x DVI and 1 Display Port  OR 1 DVI, 1HDMI, 1Display port. This allows you to have three screens that display some-
thing different.

l A Display Port to VGA or an Active Display Port to DVI adapter is required in order to connect a standardmonitor or
projector to the Display Port.

l TheHDMI connection cannot be used if you are using both DVI ports.

With this card, you will extend theWindowsDesktop on to eachmonitor in the display settings, then set EasyWorship to
use the appropriatemonitors for front of house and display foldback.

Recommended system requirements to use this option:
l ATI / AMD RADEON HD 5850/5870 & 6850/6870.
l 500 watt power supply.
l Windows 7 or Vista (WindowsXP will not work)
l Display Port to VGA or Active Display Port to DVI adapter.

https://support.easyworship.com/support/solutions/articles/6000022184-display-foldback-hardware-ew-2009-
http://support.amd.com/us/eyefinity/Pages/eyefinity-dongles.aspx
http://support.amd.com/us/eyefinity/Pages/eyefinity-dongles.aspx


See SecondaryGraphics Card or RADEON HD Graphics with Eyefinity Setup

Option 3: Two PCI Express X16 or PCI Express 2.0 Graphics Cards

Using a secondary PCI Express X16 or PCI Express 2.0 graphics cardmay also provide good results for foldback. Not all
computers have two PCI Express X16 or PCI Express 2.0 slots on themotherboard. If you are using two NVIDIA cards or
two ATI cards, make sure they are the samemodel this will help prevent driver conflicts. You can use one ATI and one
Nvidia card.

Notes
AMD/ATI Crossfire or NVIDIA SLI modes should be disabled when using this configuration.

See SecondaryGraphics Card or RADEON HD Graphics with Eyefinity Setup

Configurations We Do Not Recommend

l USB graphics cards
l Secondary or Multiple standard PCI graphics cards
l Wireless graphics devices
l NVIDIA Quadro cards



USB, Wireless & Network Video Adapters & Projectors
EasyWorship does not work with projectors that connect to your local area network. These devices normally require a soft-
ware that sends screen captures to the projector via your local area network. Windows is not able to see these types of
devices as a secondary video card, and cannot extend theWindowsDesktop to that network device. Therefore, EasyWor-
ship cannot use that device to send output to.

USB wireless video cards and USB video cards are not recommended for use with EasyWorship. USB video deviceswill
not be able to support the Directx functions required for text over video, video transitions andmany other functions in
EasyWorship.

EasyWorship can use a device that is connected to the secondary video port on your video card. For example a standard
monitor, projector or aWireless PC to TV Converter that uses a sending and receiving unit to transmit video data to the pro-
jector will . You could see some delaywith these devices.



How it Works

Schedule Area:
The Schedule Area contains selected items for a presentation. Drag and drop the items you want to use in your present-

ation into the Schedule Area. Youmay also add PowerPoint slide shows to your schedule by clicking the on the right
side of the Schedule Area. Use the arrow keys on the right side toolbar to move items around in the schedule. You can
also drag items around in the schedule. Schedules can be saved for future use.

Presentation Work Flow:
The presentation flows from the left column (Schedule Area) through the center column (Preview Area) to the right
column (Live Area). Clicking Go Live sends the current item selected to the Preview Area to the Live Area and to the
screen. The next item in the schedule is automatically selected and shown in the Preview Area. When you are finished dis-
playing the current item in the Live Area pressGo Live again to display the next item in the schedule.

Resource Area:
The Resource Area provides access to songs, scriptures, media, and online content.

Song Tab: Displays the song database.
Scripture Tab: Displays the scripture database with version option tabs at the bottom.



Media Tab: Displays the Video, Images, Feeds, DVD and Audio tabs. You can double-click on an item to project it
immediately or you can place songs, scriptures, andmedia into the schedule to create an ordered service.
Online Tab: EasyWorship has the ability to interact with the web. Click the Online tab to unlock the web features in
EasyWorship.

Downloaded Items: The downloaded items area will be blank until media or bibles have been downloaded
from theMedia Store tab.

Media Store: TheMedia Store tab allows you to purchase and downloadmedia and bibles for use in
EasyWorship. Themedia or bibles are downloaded directly into EasyWorship.

SongSelect: The SongSelect tab allows you to import songs directly into the songs database from
SongSelect. (CCLI SongSelect subscription required.)

Web: TheWeb tab allowsweb pages to be added to the schedule. YouTube videos can be streamed in full
screenmode directly from the web. This feature also allows for playback of SWF files. See Playing Flash Con-
tent

Preview Area:
The Preview Area shows the item that is currently selected either in the Resource Area or in the Schedule Area. Tomove
the contents to the Live Output Area and display it to the congregation go to the Preview Area and double-click on the
highlighted item or clickGo Live .



Live Output Area:
The Live Output Area displayswhat is currently being projected on the screen. You can navigate the contents and choose
verses to keep up with the speaker using themouse or arrow keys.

Video Jockey Mode: Video Jockey or VJmode is enabled by clicking the drop down button at the top right of the
Live Area. This is a feature that allows you to quickly change backgrounds on the fly, by just clicking on the video,
image, feed or background you wish to use.



EasyWorship Hotkeys
Presentation HotKeys:
Show Control

HOME - First Slide
END - Last Slide
DOWN - Next Slide
UP - Previous Slide
RIGHT Arrow - Next Schedule Item
LEFT Arrow - Previous Schedule Item
PAGE DOWN - Go Live
Ctrl+C - Clear text screen
Ctrl+B - Black screen
Ctrl+F - FoldBack Alert
Ctrl+L - Logo
Ctrl+N - Nursery Alert
Ctrl+M - Message Alert
Ctrl+Space Bar - Switches between live output
and control screen in singlemonitor mode

Slide Control

V <Enter> - to select the first Verse
V# <Enter> - to select Verse #

C <Enter> - to  select the first Chorus
C# <Enter> - to select Chorus #
0(Zero)<Enter> - to select the first Chorus

R <Enter> - to select the first Pre-Chorus
R# <Enter> - to select Pre-Chorus #

T <Enter> - to select the first Tag
T# <Enter> - to select Tag #

B <Enter> - to select the first Bridge
B#<Enter> - to select Bridge #

I <Enter> - to select the first Intro
I# <Enter> - to select Intro #

E <Enter> - to select the first End
E#<Enter> - to select End #

Slide Number<Enter> - to select the slide corresponding to the
number typed. Switch to the Summary View to see the slide
numbers

Song/Scripture Editor:
Shift+Enter - In the Editor - Allows you to put extra spacing between lines of text without making the next line select a new
slide.
Ctrl+A - Selects all of the text in the text editor.
Ctrl+C - Copies the selected text to the clipboard.
Ctrl+X - Cuts the selected text to the clipboard.
Ctrl+V - Pastes the text from the clipboard into the text editor.
Ctrl+Z - Undo - Reverses the last action taken.
Ctrl+Y - Redo - Reverse and Undo.

See Changing EasyWorship Hotkeys



Drag and Drop Features

Drag and Drop refers to clicking on an item and holding down the left mouse button. As you hold down the button on an
item, you canmove it to the desired location and release or drop the item. Following are the areas in which you can use the
Drag and Drop Feature:

Items Within EasyWorship:
1. Click on the Songs, Scriptures or Media tabs and select the item you wish to drag into the schedule.
2. Drag the item and release it into the Schedule Area.
3. To remove an item from the Schedule Area, click the  button on the Schedule Area or right-click on the item and

click Remove from Schedule.
4. You can also drag backgrounds onto a song in the schedule area. See Assign Background to song

Items outside EasyWorship into EasyWorship:
EasyWorship allows you to drag and drop saved schedules, videos, and images into EasyWorship. You can drop them into
the following areas: Schedule Area, Videos Resource Area, Images Resource Area, Backgrounds/Options palette.

Schedule Files:
1. Resize the working screen of EasyWorship into a smaller working window.
2. Drag any saved schedule file from anywhere in theWindows operating system into your Schedule Area in EasyWor-

ship.

Video, Images & Video Files:
1. Resize the working screen of EasyWorship into a smaller working window.
2. Drag and drop any video file from anywhere in theWindows operating system into theMedia\Videos, Images or

Audio Resource Area of EasyWorship.

Notes
EasyWorship will not copy the video or image file to Your Profile Folder/Resources/Videos, Images or Audio folder. This
feature only adds a shortcut to the folder. If you wish to add a video to the Videos or Images folder, copy the file to: Your
Profile Folder/Resources/Videos, Images or Audio
See Locating Your Profile Data to find out how to find your resources folder.
SeeWorking with Videos, Working with Images &Working with Audio Files

Background Files:
1. Resize the working screen of EasyWorship into a smaller working window.
2. Click on the Backgrounds button above the Preview area.
3. Click onOptions.
4. The Backgrounds Options window will now appear.
5. Drag and drop any video file from anywhere in theWindows operating system into theMedia \ Images Resource

Area of EasyWorship. You will now have that background tomodify or use "as is" in the Backgrounds palette. Click
OK. For more information onmodifying backgrounds seeModifying Backgrounds.

Notes
Deleting, moving or renaming the file associated with a thumbnail in EasyWorship, will cause an Exclamation Point to
appear. See Exclamation PointsOnMyThumbnails



File Menu

New Schedule: Allows you to create a new schedule file. Much like creating a newWord
document or PowerPoint presentation.
The schedule in EasyWorship contains all the songs including their lyrics and back-
grounds, PowerPoint files, images, videos and feeds for a service.

Open Schedule: Allows you to open a previously saved schedule file. This allows you to
browse your hard drive to a schedule file you have saved, much like opening a PowerPoint
presentation file.

Import Schedule: Allows you tomerge two schedules together. For example, if the
speaker wants to create a schedule with all the scriptures he wants to use and a Power-
Point slide show for his sermon notes, you can import that into the schedule you created
for the song service.

Save Schedule: Whenworking on a schedule you alwayswant to save what you are work-
ing on. Use this function to save your schedule file.

Save Schedule As: This function allows you to save your schedule in a different location
or as a different name.

Close Schedule: Allows you to close the current schedule you are working on without clos-
ing the EasyWorship program.

Print: Containsmultiple printing features.

Print Schedule (Details)...: You can print the song lyrics
for your current schedule. You can quickly access this fea-
ture by clicking the print icon on the toolbar.

Print Schedule (Summary)...: Prints a list of the songs
used in the schedule without the song text.

Print Song Activity Report...: Prints a list of the songs you
have added to the database, printed and displayed for
reporting to CCLI.

Print Song List Report...: Prints a list of all the songs in
your song database.

Reopen: Allows you to quickly reopen recently created
schedules.

Exit: Closes the EasyWorship program.



Help Menu

Contents: Takes you to the Help file for EasyWorship.

DirectX Troubleshooting: Allows you to quickly determine if DirectX sup-
port is enabled. If DirectX support is not enabled, EasyWorship will give
you the option of enabling DirectX support.

Video Codec Troubleshooting: Allows you to see how EasyWorship is pro-
cessing the videos you are displaying in EasyWorship by showing you what
codecs are being used to decode the video.

Install Microsoft PowerPoint Viewer: Allows you to download and install
PowerPoint Viewer 2010. This will only show up if Microsoft PowerPoint
2010 / 2007 Viewer or Microsoft PowerPoint 2010 / 2007 are not installed
on your computer.

Register Products...: Allows you to enter your registration information if
you haven't registered EasyWorship. Also allows you to enter serial num-
bers for new bibles you have purchased. If you are having problems regis-
tering a bible or EasyWorship, see Activating and Registering
EasyWorship, or Incorrect Serial Number!

About EasyWorship:
About: Tells you what version of the software
you have. It also tells you who the software is
registered to and what serial number was
used.

http://www.microsoft.com/downloads/details.aspx?FamilyID=cb9bf144-1076-4615-9951-294eeb832823&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=cb9bf144-1076-4615-9951-294eeb832823&displaylang=en


License: Gives you the License andWarranty
of the software.

Copyright: Gives you all of the copyright inform-
ation pertaining to the bibles we offer in
EasyWorship. This is the copyright information
you would see in the front of a bible.



Register: Allows you to enter the registration
information we sent to you. Once you register,
you will have a permanent copy instead of an
evaluation copy. See Activating and Regis-
tering EasyWorship



Live Menu

Go Live: Allows you to send the current item in the preview screen to the live
screen. Most people use theGo Live button at the top of the Preview Area or
press the Page Down key.

Alerts:
Nursery Alert: Allows you to enter the number or name of a child in the child care
area to notify the parents they are needed. See Using Nursery Alert and Nursery
Alert Tab.

Message Alert: Allows you to addmessages to the screen without creating a song.
See UsingMessages Alert andMessage Alert Tab

Hide/Show Live Output: This turns off or on EasyWorship's output to the projector.
This is the same as clicking the Live button at the top of the Live Area.

Show Logo on Live Output: Thismenu item sends the background you have selec-
ted to be the logo to the projector screen. SeeWorkingWith The Logo Button and
Setting Transitions

Blackout Live Output: This feature covers the output screen with a black screen.
SeeWorkingWith BlackClear and Logo Buttons and Setting Transitions.

Clear Text on Live Output: Clears the text of the current song from the screen leav-
ing just the background you were using. SeeWorkingWith BlackClear and Logo
Buttons and Setting Transitions

Transitions: This feature allows you to setup song to song, slide to slide, black/un-
black, clear/un-clear, logo/un-logo and video transitions.

Options: Allows you to set themany different global options for EasyWorship.



Profiles Menu

The Profiles menu containsmultiple functions. The primary function is providing the ability to select the profile you wish to
use. To change profiles, click the Profiles menu and select the profile you wish to switch to. Available profiles are listed at
the top of the Profiles menu.

Profiles Manager: Allows you to edit and create profiles in EasyWorship. See Understanding Profiles

Database Tools:
Add/Remove Demo Data: Allows you to uninstall or
install the demo songs and backgrounds that comewith
EasyWorship.

Rebuild/Fix Database: This is a tool that checks the data-
base for errors and fixes them.



Schedule Menu

Edit Song in Schedule: Allows you to edit the currently selected song in the
schedule. This is also a right-click feature. Right- clicking a song in the sched-
ule will give you the same option. See To edit a song in the schedule only

Reset to Automatic Background: Resets the background for the currently
selected song to Auto instead of the assigned background. This is also a right-
click feature.

Edit Notes: Allows you to change the notes for a song in the schedule. This is
also a right-click feature.

Add Song to Schedule: Adds the song selected in the database to the current
schedule. This is a right-click feature and a drag and drop feature.

Remove Item from Schedule: Removes the selected item in the schedule
from the schedule. This is also a right -click feature.

Move Schedule Item Up: Moves the selected item up in the schedule. This is
a right-click, drag and drop and schedule toolbar feature.

Move Schedule Item Down: Moves the selected item down in the schedule.
This is a right-click, drag and drop and schedule toolbar feature.

Add a PowerPoint Presentation...: Allows you to find a PowerPoint file on
your hard drive and add it to your schedule.

Check Schedule for Changes...: Checks the items in the schedule against
the database. If an item is different fromwhat is already in the database or a
new item, EasyWorship will give you choices for what to do with that item. See
Check schedule for Changes

Check Schedule for Errors...: Checks the schedule tomake sure it can find
all of the images, videos and backgrounds used in the schedule. If EasyWor-
ship cannot find one of them, it will ask you what to do about the error.
SeeCheck Schedule for Errors

Hide/Show Schedule Toolbar: Makes the toolbar on the right side of the
Schedule Area visible.



Songs Menu

Edit Song in Database...: Allows you to edit the currently selected song in the data-
base. This is also a right-click feature. Right- clicking the song will give you the same
option. See Editing Songs

New Song: Creates a new song in the song database. See Adding Songs

SongSelect Lyric Service: Allows you to import songs directly from the CCLI
SongSelect website. See Downloading Songs from the CCLI SongSelect Lyric Ser-
vice

Delete Song: Removes the currently selected song in the database from the data-
base. Caution: There is no recycle bin or trash for EasyWorship songs. When you
delete it, it is gone.



EasyWorship Main Toolbar

-New Schedule: Allows you to create a new schedule file. Much like creating a newWord document or PowerPoint
presentation.
The Schedule in EasyWorship contains all the songs including their lyrics and backgrounds, PowerPoint files, images,
videos and feeds for a service.

- Open Schedule: Allows you to open a previously saved schedule file. This allows you to browse your hard drive to a
schedule file you have saved, much like opening a PowerPoint presentation file. The drop down arrow gives you the option
to select a previously saved schedule from a list.

- Save Schedule: Whenworking on a schedule you alwayswant to save what you are working on. Use this function to
save your schedule file.

- New Song: Creates a new song in the song database. See Adding Songs

- Edit Song:  Edits the currently selected song. See Editing Songs

- Print Schedule (Details)...: You can print the song lyrics for your current schedule.

- Options: Allows you to set themany different global options for EasyWorship. See Setting EasyWorship Options

- Transitions: This feature allows you to setup song to song, slide to slide, black/un-black, clear/un-clear, logo/un-logo
and video transitions.



Live

Alerts -
Nursery Alert: Allows you to enter the number or name of a child in the child care area to notify the parents they are
needed. See Using Nursery Alert and Nursery Alert Tab

Message Alert: Allows you to add quick alert messages to the Front of House screen. See UsingMessages Alert
andMessage Alert Tab

Foldback Alert: Allows you to add quick alert messages to the Foldback screen.

Logo - Turns Logo on or off. SeeWorkingWith The Logo Button

Black - Blacks the screen out. SeeWorkingWith BlackClear and Logo Buttons

Clear - Clears the text of the current song from the screen. SeeWorkingWith BlackClear and Logo Buttons

Live - Turns EasyWorship output on or off.

Full View - Shows the full text of each slide in the song.

Summary View - Shows the first line of each slide.

Video Jockey Mode - Enables the VJ control window at the bottom of the live area, allowing you to change backgrounds
on the fly.



 When using PowerPoint files, the drop down arrow allows you to change the size of the thumbnails.
See Using PowerPoint Files

When going live with a scripture while showing a PowerPoint slide show, EasyWorship allows you to jump back into the
PowerPoint file you were displaying by clicking the PowerPoint button. This feature only workswith PowerPoint files and
Scriptures.

VCR Controls - Allows you to pause, play, rewind, fast forward, mute, adjust volume and turn looping on and off for
videos, DVD clips and audio files. Not all functions are available when using a video as a background.



Preview

Background - Allows you to select a global background for the songs in the schedule and currently being previewed.

Go Live - Sends the current item in the Preview Area to the Live Area.

Full View - Shows the full text of each slide in the song.
Summary View - Shows the first line of each slide.

When using PowerPoint files, the drop down arrow allows you to change the size of the thumbnails. See Using Power-
Point Files

VCR Controls - Allows you to pause, play, rewind, fast forward, mute, adjust volume and turn looping on and off for
videos, DVD clips and audio files. VCR controls are not displayed for video backgrounds in the Preview pane.



Schedule Toolbar

- Add Item to Schedule: Adds the selected song or media item to the current schedule. This is a right-click feature and
a drag and drop feature.

- Remove Item from Schedule: Removes the selected item in the schedule from the schedule. This is also a right-click
feature.

- Move Schedule Item Up: Moves the selected item up in the schedule. This is a right-click, drag and drop and sched-
ule toolbar feature.

- Move Schedule Item Down: Moves the selected item down in the schedule. This is a right, drag and drop and sched-
ule toolbar feature.

- Add a PowerPoint Presentation...: Allows you to find a PowerPoint file on your hard drive and add it to your sched-
ule.



Editor Toolbar

Type the name of the song or scripture verse here.

Click to enter copyright information for a song.

Click to import text from a text file.

Print

Cut

Copy

Paste

Undo

Increase / Decrease editor text size. This only affects the editor window and not the song or scripture font size.

Select font drop down box.

Font size by screen percentage not point.

Bold

Italic

Underline

Shadow

Outline



Font color

Click to display background list.

Resets the text attributes e.g. bold, italic, underline... back to the default settings.



Black, Clear and Logo Buttons

The black clear and logo buttons appear at the top right of the Live Area. These buttons toggle on and off.

Logo - Brings an image or video to the screen that you have already defined. SeeWorkingWith The Logo Button

Black - Transitions to Black and fromBlack. See Setting Transitions

Clear - Clears the text from the screen leaving the background running. See Setting Transitions



Using The Logo Button

EasyWorship allows you to easily display a background assigned to the Logo button. The button appears next to the Black
and Clear buttons above the Live Area. This is a toggle button that will toggle on and flash red and can be toggled off just
as you would the Black or Clear buttons.

Assign a background to the Logo button:
1. Click theBackground button above thePreview Area.
2. TheBackground palette window appears displaying the thumbnails of the backgrounds you have added to this

palette.
3. Right-click on the image or video you want to assign to the Logo button.
4. ClickSet as Logo.

Notes
To add a background to the Background palette, see Adding Backgrounds.



Dual Monitors Explained

EasyWorship is designed for dualmonitor display. Thismeans that EasyWorship displays two different monitor screens at
the same time. Monitor 1 (or the primarymonitor) displays the working or control screen, andMonitor 2 (or the secondary
monitor/projector) displays the output screen that is projected to the congregation. Dualmonitorsmake it possible to work
and set up new songs and scriptures in EasyWorship, while the congregation is viewing only the current song, scripture,
video, or feed.

EasyWorship usesWindowsExtended Desktop to accomplish this. Windows 98 SE or later is required to enableWin-
dowsExtended Desktop. The following are three different video card configurations that will allow you to useWindows
Extended Desktop.
A. Two video cardswith a single output on each card (not recommended)
B. A single video card with two outputs (recommended)
C. A laptop with a video output on the back of the laptop.

Here are themost commonways to setup a computer for dualmonitor output.
l Split the secondmonitor display signal and send
one cable to a second computer monitor and the
other to the projector.



l EasyWorshipmay also be setup with a singlemonitor
on the desk to control the software and use your pro-
jector as the secondarymonitor.

l Customers using laptopswill use their laptopmonitor
asMonitor 1 and the output on the back of the laptop
for Monitor 2.

l Youmay also add a video splitter to the output on the
laptop in order to utilize a secondmonitor on the desk
and a projector.



Notes
Projection bulbs are very expensive and have a use life. A monitor may be less expensive and doesn't require that you run
your projector while setting building schedules during the week!

See Can I Run EasyWorship in SingleMonitor Mode? for more information about running EasyWorship with only one
video output.

See EnablingWindowsExtended Desktop for instructions on how to check a computer for DualMonitor compatibility and
for instructions on setting up DualMonitors to use with EasyWorship.

See Computer Requirements Video Card and Computer Requirements Unsupported for help with choosing the correct
video card for your system.

See DualMonitor Troubleshooting if you are having problemswith your dualmonitor setup.



Dual Monitor / Projector Setup
If you are using a laptop computer, see Laptop Setup

Enabling Windows Extended Desktop:

Windows 7:
1. Hold down theWindows key on the keyboard and press P.
2. Use your mouse to select Extend.

Windows XP, Vista & 7:
1. Right-click on theWindowsDesktop.
2. Select:

Windows XP: Properties, then Settings tab.
Windows Vista: Personalize then Display Settings link.
Windows 7: Screen Resolution



Notes
If Display 1 and 2 boxes do not appear, your computer does not have dualmonitor capability, or you do not have a pro-
jector or monitor plugged into the secondary video output on the computer.

3. Select Monitor 2.

4. Select Extend my Windows Desktop onto this monitor or select Extend these displays from the drop down list..

5. Set the screen area resolution.
Standard 4:3 -800 X 600 or 1024 X 768
Widescreen 16:9 -852x480, 1280x720 or 1920x1080
Widescreen 16:10 - 1280x768, 1280x800 or 1440x900

6. Verify the color setting for Monitor 2 is set to 32 bit.



7. Click Apply thenOK. If prompted to keep the settings click yes.
8. Open EasyWorship.
9. Follow the instructions below to setup EasyWorship to use your secondmonitor.

Setting EasyWorship to use your second monitor:
1. Click on the Livemenu.
2. ClickOptions.

3. Under General, go to Select Output Monitor and select Secondary Monitor from the drop down list.
4. Make sure the Enable DirectX Support check box is checked.
5. ClickOK.

See DualMonitor Troubleshooting if you are having problemswith your dualmonitor setup.
See Can I Run EasyWorship in SingleMonitor Mode? for more information about running EasyWorship if your computer
isn't able to support dualmonitors.



Laptop Setup

Connecting the Laptop:
1. With the laptop turned off, turn on the projector, or secondmonitor.
2. Connect the secondmonitor cable from the projector, or secondmonitor to the laptop.
3. Make sure the projector, monitor is on and in the right mode to receive a computer signal.
4. Now turn on the laptop.
5. Now determine what graphics card you have.

Determine What Graphics Card You Have:
The type of graphics card you have can be determined by following the steps below.

1. Right-click on theWindowsDesktop.
2. Select:

Windows XP: Properties, then Settings tab.
Windows Vista: Personalize then Display Settings link.
Windows 7: Screen Resolution

3. Click the Advanced button or Advanced Settings link at the bottom right.
4. Click the Adapter tab to see the type of video card you have.

This computer has a NVIDIA GeForce 9800GTGraphics Card.

6. Follow the steps in DualMonitor Setup for NVIDIA and ATI graphics cards.
Follow the steps in Intel GraphicsMonitor Setup for Intel Graphics cards.

See DualMonitors Explained for more information about how laptopswork in dualmonitor mode.

See Can I Run EasyWorship in SingleMonitor Mode? for more information about running EasyWorship if your computer
isn't able to support dualmonitors.



Intel Graphics Monitor Setup

1. Right-click on theWindowsDesktop.
2. ClickGraphics Properties.

This window will appear:

3. Under Devices or Display Devices click on the Extended Desktop option.
4. The Primary Device should be Notebook.
5. The Secondary Device should beMonitor.
6. ClickOK.
7. Open EasyWorship
8. Click on the Livemenu.
9. ClickOptions.



10. Under General, go to Select Output Monitor and select Secondary Monitor from the drop down list.
11. Make sure the Enable DirectX Support check box is checked.
12. ClickOK.

See DualMonitor Troubleshooting if you are having problemswith your dualmonitor setup.
See Can I Run EasyWorship in SingleMonitor Mode? for more information about running EasyWorship if your computer
isn't able to support dualmonitors.



Display Foldback Monitor Setup

Secondary Graphics Card or RADEON HD Graphics with Eyefinity Setup:
Using the DualHead2Go box is the recommended hardware for foldback; however, a secondary video card or a single
RADEON HD Graphics Card with Eyefinitymay be used for foldback purposes.

Step 1: Enable Extended Desktop for three monitors.
See DualMonitor Setup for help with extending the Desktop.
See Display FoldbackHardware

Step 2: Front of House Settings:
1. In EasyWorship click the Options button on the toolbar.
2. Under General, Select Output Monitor, changeOutput Monitor to Primary Monitor.
3. ClickOK.

Step 3: Foldback Settings:
1. In EasyWorship, click the Livemenu then Display Foldback Options.
2. Under Monitor Options, Select Foldback Monitor, change Foldback Monitor to Secondary Monitor.
3. ClickOK.

Matrox DualHead2Go Setup:
When using aMatroxDualHead2Go box, the secondary output from the video card is spanned across twomonitors. The
screen resolution for that monitor is double wide. For example, twomonitors at 1024x768 would be 2048x768 using the
MatroxDualHead2Go. EasyWorship is able to use half of that screen for the front of house and half for the foldback.

Finding the Width and Height of both Monitors:
1. Right-click on theWindowsDesktop.
2. Windows XP: Properties, then Settings tab.

Windows Vista: Personalize then Display Settings link.
Windows 7: Screen Resolution

3. Click eachmonitor to determine the size.
4. The size will be displayed in the Resolution Area. e.g. 1024x768

Example:

Notes



In the example, Monitor 1 is 1024 wide by 768 tall andMonitor 2 is 2048 wide by 768 tall. Write this information down for
use in the following steps.

Front of House Settings:
1. In EasyWorship click the Options button on the toolbar.
2. Under General select Custom Position from theOutput Monitor drop down box.
3. Change Left to equal the width of monitor 1.
4. Change Top to 0.
5. ChangeWidth to half the width of monitor 2.
6. Change Height to match the height of monitor 2.
7. ClickOK.

Example:

With these display settings in theWindows operating system, use the following custom position settings in EasyWor-
ship Options.

Left: Monitor 1Width = 1024 Top: Almost always is zero
Width: Monitor 2 width divided by 2 = 1024 Height: Monitor 2 height = 768

Foldback Settings:
1. In EasyWorship click the Livemenu, then Display Foldback Options.
2. Check Enable support for display foldback (stage display) under Monitor Options.
3. Select Custom Position from Foldback Monitor drop down box.
4. Change Left to the width of Monitor 1 + half the width of Monitor 2
5. Change Top to 0.
6. ChangeWidth to half the width of Monitor 2.
7. Change Height to match the height of Monitor 2.
8. ClickOK.

Example:



With these display settings in theWindows operating system, use the following custom position settings in EasyWor-
ship Display Foldback Options.

Left: Monitor1Width + half the width of monitor 2 = 2048 Top: Almost always is zero
Width: Monitor 2 width divided by 2 = 1024 Height: Monitor 2 height = 768

Matrox DualHead2Go Connection Examples:

With a Splitter:

Without a Splitter:

With a Splitter & Switcher:



In this diagram the switcher allows you to show either the foldback view on the foldback screen or the front of house
view on the foldback screen.



Using Custom Position

Here are a couple of reasons to use the custom position.
l Building services at home so that the displaymatches the presentation computer.
l Using the Foldback feature with theMatroxDualHead2Go.

Building Services At Home:

If a schedule is built on a computer using a different output resolution than the presentation computer, the songswill not dis-
play correctly on the presentation computer. Setting a custom resolution on the source computer will correct this problem.

On the Presentation Computer
Determine the output screen size of the presentation computer.

1. Open display settings on the presentation computer.
2. Click on the secondmonitor.
3. The resolution for that screen will be displayed there. e.g.

1024x768.

On the Home Computer
1. Open EasyWorship on your home computer.
2. Click on theOptions button on the toolbar.
3. Under General, Select Output Monitor, changeOutput

Monitor to Custom Position.
4. Change theWidth and Height to match the presentation

computer.
5. ClickOK.

Using Foldback:
See FoldbackMonitor Setup



Dual Monitor Troubleshooting

Issue: I see the same thing onmy secondmonitor as I see onmy primarymonitor.
Cause: Your WindowsDesktop has not been extended to the secondmonitor.
Resolution: Enable theWindows Extended Desktop. See DualMonitor Setup

Issue: I enabled theWindowsExtended Desktop, but it disables itself after I apply the setting.
Cause: You have an Intel Graphics card, or you do not have your projector connected to your secondary video port, or the
projector is not turned on.
Resolution: Use the instructions in Setting UpDualMonitors to enable theWindowsExtended Desktop for your Intel
Graphics card. Connect your projector or secondarymonitor to the secondarymonitor port on your graphics card and
make sure that themonitor, or projector, is turned on.

Issue:WindowsExtended Desktop is enabled, but EasyWorship still displays the output onmy primarymonitor.
Cause: The secondarymonitor is not selected as the output monitor in EasyWorship.
Resolution: Click on the Livemenu, thenOptions. Select the Secondary Monitor at the bottom left of the General tab
under Select Output Monitor. ClickOK.

Contact Customer Support if your problem cannot be resolved by following the steps above.



General Options

TheGeneral window allows you to choose an output monitor, and set screenmargins.

Setting General options:
1. Click the Options button on the toolbar.
2. In the Options window, clickGeneral.

Below is an explanation of the options available in the General Area.

Margins:

Screen Margin % allows you to set the percentages of screen to indent, due to the projector over shooting the phys-
ical output screen.
Text Margin % allows you to set themargins that you want around the text. Thesemargins only affect the text, not
the background.
Bleed Margin % allows you to set margins for themessage alert, nursery alert and copyright information to bleed
over. These settings are typically used when you are over and under scanning your output by sending it to a TV and
a projector at the same time.

Select Output Monitor:



Output Monitor Click themonitor that you want to use to display your presentation to the congregation. The Select
Output Monitor list only contains outputs that you have enabled in theWindowsOperating System.
Primary Monitor allows the live output to be displayed on the primarymonitor behind the EasyWorship control
screen.
Secondary Monitor allows the live output to be displayed on a secondarymonitor. See DualMonitor Setup
Custom Position allows you to specify an absolute position and size to project the output.
Custom Position Settings, type or select the desired positions. The custom positions are set in pixels. The default
settings are Left: 0 Top: 10Width: 426 Height: 341. This places the live output box at the top left of your monitor. See
Using CustomPosition



Songs

The Songs window allows you to customize how songs are displayed. You can chose text alignment, font size, style, color
and capitalization rules. You can also choose whether or not to display labels, and specify their location, size, style and
color.

Setting Songs options:
1. Click the Options button on the toolbar.
2. In the Options window, click Songs.

Below is an explanation of the options available in the Songs Area.

Song Options:
Under song optionsmake changes to font types, styles, output dimensions, etc., without having to worry about going back
andmodifying all your songs to fit the screen.

Text Alignment sets the desired horizontal position for the text.



Vertical Align sets the desired vertical position for the text.
Desired Font Height Percentage sets the desired font size.
Song Font allows you to control the song font, style, color, shadow and outline.

Verse/Chorus Label Options:
Show Verse/Chorus Labels enables the verse, chorus, and other tags on the live output screen.
Label Location sets the desired position for the label.
Label Indent indents the verse, chorus... label when displayed on the output screen.
Label Size sets the desired size for the label.
Color Coding specifies a color scheme for the Preview and Live Output Areas.

l In the appropriate lists, click the desired colors. The Sample Area on the right displays the color
scheme. ClickOK when you are satisfied with the color scheme.

Label Font allows you to control the verse/chorus font, style, color, shadow and outline.

Word Formatting Options:
l Specify whether or not wordswrap, set capitalization rules, and add words to the auto capitalize list.

Notes
EasyWorship uses font sizes differently than other Windows-based applications. See Font Sizing Explained



Scripture

The Scripture window allows you to customize how scriptures are displayed. You can choose scripture alignment and font
size, style, and color. You can also specify reference font size, style, and color.

Setting Scripture options:
1. Click the Options button on the toolbar.
2. In the Options window, click Scripture.

Below is an explanation of the options available in the Scripture Area.

Scripture Options:
Enable Scripture Support enables the scriptures tab in the Resource Area.
Text Alignment sets the desired horizontal position for the scripture.
Vertical Align sets the desired vertical position for the scripture.
Desired Font Height Percentage sets the desired font size. EasyWorship uses this font size for all scriptures.
Scripture Font allows you to control the scripture font, style, color, shadow and outline.

Notes
EasyWorship uses font sizes differently than other Windows-based applications. See Font Sizing Explained

Scripture Reference:
Reference Location sets the desired position for the scripture reference.
Reference Size sets the desired size for the scripture reference.
Reference Indent indents the scripture reference.
Show Reference Only causes EasyWorship to only display only the scripture reference.
Reference Font allows you to control the reference font, style, color, shadow and outline.



Alerts

Set Alerts options:
1. Click the Options button on the toolbar.
2. In the Options window, click Alerts.

Below is an explanation of the options available in the Alerts Area.

Nursery Alert Options:
The Nursery Alert options allows you to chose whether or not amessage can be displayed to the congregation. Youmay
also specify its location, height, font, background color, and length of display.

Enable Nursery Alert makes the Nursery Alert option appear under the alerts drop down in the Live Area.
Screen Location allows you to set the location of where the alert appears on the screen.
Height Percentage allows you to set the desired height percentage for the nursery alert text.
Background Color allows you to select the desired color for the background of the nursery alert.
Display Seconds specifies the number of seconds that you want the nursery alert to display.
Nursery Font allows you to control the alert font, style, color, shadow and outline.

Message Alert Options:
TheMessage Alert options allows you to chose whether or not amessage can be displayed to the congregation. Youmay
also specify its location, height, font, background color, and displaymethod and speed.



Enable Message Alert makes theMessage Alert option appear under the alerts drop down in the Live area.
Screen Location allows you to set the location of where the alert appears on the screen.
Height Percentage allows you to set the desired height percentage for themessage alert text.
Background Color allows you to select the desired color for the background of themessage alert.
Desired Display Method

l Static displays the entire message at once.
l Scroll displays themessagemoving across the screen from right to left.
l Scroll if Needed displays themessagemoving across the screen only if it is too long.

Speed Slider sets the desired speed to control how long themessage is displayed or how quickly it will scroll.
Message Font allows you to control the alert font, style, color, shadow and outline.



Copyright Info

TheCopyright Info window allows you to chose whether or not the copyright for a song is displayed and allows you to spe-
cify its font, style, color, shadow, outline, and height. You can also choose to display your CCLI number or other license
information.

Notes
The copyright information for a song is only available if you have entered the information into the Song Information dialog
box in the Editor. For details on entering copyright information for a specific song, see Displaying Copyright Information

Setting copyright options:
1. Click the Options button on the toolbar.
2. In the Options window, click Copyright Info.

Below is an explanation of the options available in the Copyright Info Area.

Display Copyright Information causes the copyright information to be displayed at the bottom left of the screen..
Font allows you to select the desired font for the copyright.
Style allows you to select the desired style for the copyright.
Color allows you to select desired color for the copyright.
Shadow Color when checked enables the shadow on the copyright text. The color may also be selected from the
drop down list.
Outline Color when checked enables the outline on the copyright text. The color may also be selected from the drop
down list.
Height Percentage allows you to set the desired height percentage for the copyright text.
License Info is where you enter a CCLI license number, or any other license information that you want to display.

Notes



l For more information on how to obtain a copy license go to www.CCLI.com.
l To view the copyright information's size and placement on the output monitor, on the Livemenu clickOptions, click
the Copyrights Information tab, and then click the Preview Live Output check box.

http://www.ccli.com/


Advanced Options

The Advanced window allow you to choose Live, PowerPoint, DVD andDirectX options.

Setting Advanced options:
1. Click the Options button on the toolbar.
2. In the Options window, click Advanced.

Below is an explanation of the options available in the Advanced Area.

Live Options:
Show live screen on startup when checked will enable the live output when EasyWorship opens. The last used
background will display on the output screen.
Advance Schedule after Go Live is pressed enables EasyWorship to select the next item in the scheduled auto-
matically, when theGo Live button is clicked.

PowerPoint Options:
Use PowerPoint application instead of Viewer enables EasyWorship to load the full version of PowerPoint to dis-
play PowerPoint slide shows.

If PowerPoint is not installed on this computer, leave this option unchecked to use the Power-
Point viewer that is installed with EasyWorship.



Build thumbnails with PowerPoint Application enables EasyWorship to create thumbnails using the full Power-
Point application.

DVD Options:
User Preferred Video Codecs causes EasyWorship to look for and use either the Cyberlink or Dscaler mpg2 if they
are available. EasyWorship ignores other decoders if one of these two codecs are available.
Prevent DVD SpinDown keeps the DVD in the drive spinning at all times to reduce the amount of time needed to
send a DVD clip to the screen.

DirectX Options:
Enable DirectX Support enables EasyWorship to use the DirectX to display transitions and text over video back-
grounds.
Vertical Retracing Checking

l Auto allowsDirectX control when Vertical Retrace Checking is used.
l On usesDirectX to create a smooth transition between slides and produce the cleanest output.
l Off turns this fuction off.

Notes
The advantage of using vertical retrace checking is that it creates a smooth transition and a clean video playback.
The disadvantage of using vertical retrace checking is that it slows down processing time.

Video Quality
l Move the slider toward Quality to increase the time EasyWorship allocates for displaying videos or live feeds.
The higher the quality, the smoother the playback. Setting the VideoQuality all the way to Quality can cause
some computers to run slower.

l Move the slider toward Speed to decrease the time EasyWorship allocates for displaying videos or live feeds.
This reduces the quality of the playback.

Notes
 Usually, placing the slider in the center provides the best quality without toomuch overhead on the computer.



Setting Transitions

EasyWorship allows you to easily set impressive transitions for songs, slides, black screen, clear screen, and video. You
can choose one transition or many different transitions for your presentation.

1. Click Transitions on the toolbar.
Below is an explanation of the options available in the Transitions Area.

Selecting a transition:
Black Screen: Select different transitions for Black screen and un-Black screen.
Clear Screen: Select different transitions for Clear screen and un-Clear screen.
Logo: Select different transitions for Logo screen and un-Logo screen.
Advanced:

Enable Video Transitions Allows for the transition from one video background to the next.
Disable the more complex video transitions disables 3D transitions for slower computers.
Always pause videoswhen transitioning from video to another element pauses the video when transitioning
from one element to the other.

Notes
Use the Shift key or the Ctrl key to choosemultiple transitions from the list. Multiple transitions are applied in the order
they are selected to your songs and slides.



Displaying Copyright Information

EasyWorship allows you to display copyright information for the displayed song. First youmust enter your CCLI # which
will appear in each copyrighted song, automatically.

1. To enter copyright information:
2. On the Livemenu, clickOptions.
3. Click the Copyrights tab.
4. Enter your CCLI # in the License Info box (e.g., CCLI 123456789).

l TheCCLI # will appear on every song that has copyright information entered into the information area of the
song.

5. Select the Display Copyright Information check box to display the author, title, administrator, and copyright inform-
ation for specific songs. EasyWorship allows you to edit and add to the author, title, and copyright information.

6. ClickOK.

Edit or Add Information to a Song:
1. Right-click on the desired song and click Edit Song.
2. Click Information on the toolbar.
3. The Song Information dialog box appears.

4. Type the information in the appropriate boxes.
5. Click in the Copyright box, and then click the Copyright icon to add the copyright symbol and automatically turn on

the CCLI# function . You can also add a date after the copyright symbol.
6. The Song Number box is for assigning a CCLI Database Song Number from the CCLI Song Select web site. This is

for song reporting with CCLI and not for display.
7. ClickOK.



Display Foldback

Display Foldback allows EasyWorship to take advantage of a third video output to display content for stagemonitors. Addi-
tional hardware is required to use this feature. TheMatroxDualHead2Go box is recommended for this feature. See Dis-
play FoldbackMonitor Setup and FoldbackHardware

Foldback Features:

l Send Lyrics and Scripture content to stagemonitors (automatically synced with audience output)
l Send Alerts and custommessages to stagemonitors (only seen on stage)
l ClockDisplay shows the current time
l Lyric Display, optional verse/chorus tags, shows first line of next slide, automatic word wrap, andmore
l PowerPoint Display shows current and next PowerPoint slides
l Full control of format and style, including: text/font styles, custom background (not just black), scrolling or static
alerts, andmore (requires additional hardware)

SeeMonitor Options, Songs Text, Scripture Text, PowerPoint Options, and Alerts and Time



Display Foldback Monitor Setup

Secondary Graphics Card or RADEON HD Graphics with Eyefinity Setup:
Using the DualHead2Go box is the recommended hardware for foldback; however, a secondary video card or a single
RADEON HD Graphics Card with Eyefinitymay be used for foldback purposes.

Step 1: Enable Extended Desktop for three monitors.
See DualMonitor Setup for help with extending the Desktop.
See Display FoldbackHardware

Step 2: Front of House Settings:
1. In EasyWorship click the Options button on the toolbar.
2. Under General, Select Output Monitor, changeOutput Monitor to Primary Monitor.
3. ClickOK.

Step 3: Foldback Settings:
1. In EasyWorship, click the Livemenu then Display Foldback Options.
2. Under Monitor Options, Select Foldback Monitor, change Foldback Monitor to Secondary Monitor.
3. ClickOK.

Matrox DualHead2Go Setup:
When using aMatroxDualHead2Go box, the secondary output from the video card is spanned across twomonitors. The
screen resolution for that monitor is double wide. For example, twomonitors at 1024x768 would be 2048x768 using the
MatroxDualHead2Go. EasyWorship is able to use half of that screen for the front of house and half for the foldback.

Finding the Width and Height of both Monitors:
1. Right-click on theWindowsDesktop.
2. Windows XP: Properties, then Settings tab.

Windows Vista: Personalize then Display Settings link.
Windows 7: Screen Resolution

3. Click eachmonitor to determine the size.
4. The size will be displayed in the Resolution Area. e.g. 1024x768

Example:

Notes



In the example, Monitor 1 is 1024 wide by 768 tall andMonitor 2 is 2048 wide by 768 tall. Write this information down for
use in the following steps.

Front of House Settings:
1. In EasyWorship click the Options button on the toolbar.
2. Under General select Custom Position from theOutput Monitor drop down box.
3. Change Left to equal the width of monitor 1.
4. Change Top to 0.
5. ChangeWidth to half the width of monitor 2.
6. Change Height to match the height of monitor 2.
7. ClickOK.

Example:

With these display settings in theWindows operating system, use the following custom position settings in EasyWor-
ship Options.

Left: Monitor 1Width = 1024 Top: Almost always is zero
Width: Monitor 2 width divided by 2 = 1024 Height: Monitor 2 height = 768

Foldback Settings:
1. In EasyWorship click the Livemenu, then Display Foldback Options.
2. Check Enable support for display foldback (stage display) under Monitor Options.
3. Select Custom Position from Foldback Monitor drop down box.
4. Change Left to the width of Monitor 1 + half the width of Monitor 2
5. Change Top to 0.
6. ChangeWidth to half the width of Monitor 2.
7. Change Height to match the height of Monitor 2.
8. ClickOK.

Example:



With these display settings in theWindows operating system, use the following custom position settings in EasyWor-
ship Display Foldback Options.

Left: Monitor1Width + half the width of monitor 2 = 2048 Top: Almost always is zero
Width: Monitor 2 width divided by 2 = 1024 Height: Monitor 2 height = 768

Matrox DualHead2Go Connection Examples:

With a Splitter:

Without a Splitter:

With a Splitter & Switcher:



In this diagram the switcher allows you to show either the foldback view on the foldback screen or the front of house
view on the foldback screen.



Monitor Options

Setting Monitor Options:
1. Click the Live Menu then Display Foldback Options.
2. In the Display Foldback Options window, clickMonitor Options.

Below is an explanation of the options available in theMonitor Options Area.

Enable Display Foldback:
Enable support for display foldback (stage display) enables the foldback feature.

Margins:
Screen Margin % allows you to set the percentages of screen to indent, due to the projector over shooting the phys-
ical output screen.
Text Margin % allows you to set themargins that you want around the text. Thesemargins only affect the text, not
the background.
Bleed Margin % allows you to set margins for themessage alert, nursery alert and copyright information to bleed
over. These settings are typically used when you are over and under scanning your output by sending it to a TV and
a projector at the same time.



Select Foldback Monitor:
Click themonitor that you want to use to display your presentation to the congregation. The FoldbackMonitor list only con-
tains outputs that you have enabled in theWindowsOperating System..

Primary Monitor allows the live output to be displayed on the primarymonitor behind the EasyWorship control
screen.
Secondary Monitor allows the live output to be displayed on a secondarymonitor. See DualMonitor Setup
Custom Position allows you to specify an absolute position and size to project the output.
Custom Position Settings, type or select the desired positions. The custom positions are set in pixels. See Using
CustomPosition



Song Text

The Song Text window allows you to customize how songs are displayed on the foldback screen. You can chose text align-
ment; font size, style, color and capitalization rules. You can also choose whether or not to display labels, and specify their
location, size, style and color.

Setting Song Text options:
1. Click the Live menu then Display Foldback Options.
2. In the Display Foldback Options window, click Song Text

Below is an explanation of the options available in the Song Text Area.

Song Options:
Under song optionsmake changes to font types, styles, output dimensions, etc., without having to worry about going back
andmodifying all your songs to fit the screen.



Text Alignment sets the desired horizontal position for the text.
Vertical Align sets the desired vertical position for the text.
Desired Font Height Percentage sets the desired font size.
Song Font allows you to control the song font, style, color, shadow and outline.
Show first line of next slide enables EasyWorship to display the first line of the next slide or the title of the next item
in the schedule.
First Line Font allows you to control the first line font, style, color, shadow and outline.

Verse/Chorus Label Options:
Show Verse/Chorus Labels enables the verse, chorus, and other tags on the live output screen.
Label Location sets the desired position for the label.
Label Size sets the desired size for the label.
Indent Label indents the verse, chorus... label when displayed on the output screen.
Label Font allows you to control the verse/chorus label font, style, color, shadow and outline.

Word Formatting Options
l Specify whether or not wordswrap, set capitalization rules, and add words to the auto capitalize list.

Notes
EasyWorship uses font sizes differently than other Windows-based applications. See Font Sizing Explained



Scripture Text

The Scripture Text window allows you to customize how scriptures are displayed on the foldback screen. You can choose
scripture alignment; and font size, style, and color. You can also specify reference font size, style, and color.

Setting Scripture Text options:
1. Click the Live menu then Display Foldback Options.
2. In the Display Foldback Options window, click Scripture Text.

Below is an explanation of the options available in the Scripture Text Area.

Scripture Options:
Enable Scripture Support enables the scriptures tab in the Resource Area.
Text Alignment sets the desired horizontal position for the scripture.
Vertical Align sets the desired vertical position for the scripture.
Desired Font Height Percentage sets the desired font size. EasyWorship uses this font size for all scriptures.
Scripture Font allows you to control the scripture font, style, color, shadow and outline.

Notes
EasyWorship uses font sizes differently than other Windows-based applications. See Font Sizing Explained

Scripture Reference:
Reference Location sets the desired position for the scripture reference.
Reference Size sets the desired size for the scripture reference.
Reference Indent indents the scripture reference.
Show Reference Only causes EasyWorship to only display only the scripture reference.
Reference Font allows you to control the reference font, style, color, shadow and outline.



PowerPoint Options

Setting PowerPoint Options:
1. Click the Livemenu then Display Foldback Options.
2. In the Display Foldback Options window, click PowerPoint Options.

Below is an explanation of the options available in the PowerPoint Options Area.

Slide Preview:
Show Slide Preview enables the viewing of the full PowerPoint slide on the foldback screen instead of just thumb-
nails.
Mirror Live Output allows EasyWorship to display animations that are also displayed on the front of house screen.
Update Speed controls how quickly EasyWorship updates the foldback screen. Slow will cause the animations to
bemore choppy, while Quality will make themmore fluid.

Thumbnails:
Show Thumbnails enables viewing thumbnails of the PowerPoint slides on the foldback screen.
Screen Location controls the location of the thumbnails on the foldback screen.
Thumbnail Size controls the size of the thumbnails on the foldback screen.



PowerPoint on the Foldback Screen

EasyWorship will also display PowerPoint slide shows on the Foldbackmonitor; however, the foldback view provided
more information for the people on the stage than the Front of House screen. On the foldback screen, the PowerPoint
slide will appear like the Front of House, but foldback also has the ability to show the thumbnails of the slides in the present-
ation, allowing people on stage to see what is currently selected along with what the next and previous slides are.

See PowerPoint Options under Display Foldback for a list of options available for displaying PowerPoint on the foldback
screen.



Alerts and Time

To set Alerts and Time options:
1. Click the Live menu then Display Foldback Options.
2. In the Display Foldback Options window, click Alerts and Time.

Below is an explanation of the options available in the Alerts and Time Area.

Clock Options:
Enable Clock shows the clock on the foldback screen.
Screen Location controls the location of the clock on the foldback screen.
Height Percentage controls the size of the clock font.
Background Color sets the color of the background behind the clock.
Clock Font allows you to control the clock's font, style, color, shadow and outline.

Foldback Alert Options:
The Foldback Alert Options allows you to chose whether or not an alert can be displayed on the foldback screen. You
may also specify its location, height, font, background color, and displaymethod and speed.

Enable Foldback Alert makes the Foldback Alert option appear under the alerts drop down in the Live Area.
Screen Location allows you to set the location of where the alert appears on the screen.
Height Percentage allows you to set the desired height percentage for the foldback alert text.
Background Color allows you to select the desired color for the background of the foldback alert.
Desired Display Method



l Static displays the entire message at once.
l Scroll displays themessagemoving across the screen from right to left.
l Scroll if Needed displays themessagemoving across the screen only if it is too long.

Speed Slider sets the desired speed to control how long themessage is displayed, or how quickly it will scroll.
Alert Font allows you to control the alert font, style, color, shadow and outline.



Display Foldback Hardware

There aremultiple ways to configure your computer hardware to support a third monitor for display foldback. See the dif-
ferent options below.

Option 1: Matrox DualHead2Go

TheDualHead2Go comes in three editions. Analog, Digital and DP. We only recommend either the Analog or Digital Edi-
tions. The DP edition is only for use with Display Port monitors.

The Analog Edition is the cheapest of the three and only has VGA connections. It has amaximum resolution of 2 x 1280 x
1024.

l 4:3 resolutions for EasyWorship with this box are 2 x 800x600 or 2 x 1024x768
l 16:9 resolution for EasyWorship with this box is 2 x 1280 x 720.

The Digital Edition has two DVI outputs. It has amaximum resolution of 2 x 1920 x 1200.

l 4:3 resolutions for EasyWorship with this box are 2 x 800x600, 2 x 1024x768, 2 x 1280x1024.
l 16:9 resolutions for EasyWorship with this box are 2 x 1280 x 720 and 2 x 1920x1080

Notes
If you need to use independent resolutions for the foldback and front of house screens, you'll probably want use option 2 or
3.

See FoldbackMonitor Setup for help setting up EasyWorship to work with this device.
See Display FoldbackHardware for help purchasing the DualHead2Go.

Option 2: ATI / AMD RADEON HD 5850/5870 & 6850/6870 With Eyefinity

The ATI / AMD RADEON HD 5850/5870 & 6850/6870 cards have four video outputs; three can be used simultaneously;
2 x DVI and 1 Display Port  OR 1 DVI, 1HDMI, 1Display port. This allows you to have three screens that display some-
thing different.

l A Display Port to VGA or an Active Display Port to DVI adapter is required in order to connect a standardmonitor or
projector to the Display Port.

l TheHDMI connection cannot be used if you are using both DVI ports.

With this card, you will extend theWindowsDesktop on to eachmonitor in the display settings, then set EasyWorship to
use the appropriatemonitors for front of house and display foldback.

Recommended system requirements to use this option:
l ATI / AMD RADEON HD 5850/5870 & 6850/6870.
l 500 watt power supply.
l Windows 7 or Vista (WindowsXP will not work)
l Display Port to VGA or Active Display Port to DVI adapter.

https://support.easyworship.com/support/solutions/articles/6000022184-display-foldback-hardware-ew-2009-
http://support.amd.com/us/eyefinity/Pages/eyefinity-dongles.aspx
http://support.amd.com/us/eyefinity/Pages/eyefinity-dongles.aspx


See SecondaryGraphics Card or RADEON HD Graphics with Eyefinity Setup

Option 3: Two PCI Express X16 or PCI Express 2.0 Graphics Cards

Using a secondary PCI Express X16 or PCI Express 2.0 graphics cardmay also provide good results for foldback. Not all
computers have two PCI Express X16 or PCI Express 2.0 slots on themotherboard. If you are using two NVIDIA cards or
two ATI cards, make sure they are the samemodel this will help prevent driver conflicts. You can use one ATI and one
Nvidia card.

Notes
AMD/ATI Crossfire or NVIDIA SLI modes should be disabled when using this configuration.

See SecondaryGraphics Card or RADEON HD Graphics with Eyefinity Setup

Configurations We Do Not Recommend

l USB graphics cards
l Secondary or Multiple standard PCI graphics cards
l Wireless graphics devices
l NVIDIA Quadro cards



Video Jockey

Video Jockey or VJ is a feature that allows you to quickly change backgrounds on the fly, by just clicking on the video,
image, feed or background you wish to use while displaying a song or scripture.

Using VJ:
1. Open EasyWorship.
2. In the Live Area, click the button at the top right.
3. Select VJ Mode.
4. The lower section of the Live Area will now display tabs at the bottom for Videos, Images, Feeds and

Backgrounds.
5. Click on any video, image, feed or background to change the background of the song, or scripture this is live.

Notes
VJMode is only available when a song or scripture is in the Live Area.



Building and Running an EasyWorship Schedule

EasyWorship allows you to easily create and save a list of items to be displayed in your service. This list of items is called a
Schedule. Songs, Scriptures, Videos, PowerPoint slides, Feeds, DVD clips, Audio Files andWebContent can be added
to the schedule. EasyWorship schedule files include all of the information needed to display song text with the appropriate
background, images, PowerPoint slide shows.With the pack videos in schedule feature, video and audio added to the
schedule will also be contained in the schedule file.

Creating and Saving a Schedule:
When EasyWorship is opened, a blank schedule is automatically created. Click create a new schedule

on the toolbar to start over with a new schedule. Click Save Schedule to save the schedule, or click
the File menu, then Save Schedule As.

Adding Content To The Schedule:

Using Drag And Drop:
1. Drag a resource (Song, Scripture, Video, Feed, Image, DVD Clip, Audio file) from the Resource Area below

the schedule into the Schedule Area.
2. Youmay drag items up and down in the schedule for appropriate placement in the schedule.

Using the Schedule Toolbar:
1. In the Resource Area, click Songs, Scriptures or Media.
2. Select a Song, Scripture, Video, Feed, Image, DVD Clip, Audio file
3. Click the Add icon to add it to the schedule.
4. Click the Delete icon to remove a resource from the schedule.

5. Click the Up Arrow and Down Arrow icons to place the resources in the
desired order.

Adding PowerPoint:
1. Click the PowerPoint icon to add a PowerPoint file to the schedule.
2. Browse to the PowerPoint file you wish to use using the browse window that appears.
3. Select the PowerPoint file and clickOpen. For more information see Using PowerPoint Files

Adding Web Content:
1. Click the Online tab, thenWeb tab.
2. Browse to the web page you would like to display.
3. Click the Schedule button at the top right.



Pack Video And Audio Into Schedule:

EasyWorship will allow you to bring video and audio with you via the schedule file. You no longer have to worry about the
audio or video files being available at the computer you are taking the schedule to.

1. Click the File menu then Save Schedule As.
2. At the bottom of the Save Schedule As screen check the Pack videos in schedule box.
3. Type the name of the file in then click Save.

Schedule Views:
1. Summary View is a view that will only show the icon and title of each item in the schedule.

2. Full View is a view that will also show a thumbnail of the background associated with that song or the default back-
ground. Click the down triangle at the top right of the schedule area to change views. It also displays the notes for
each schedule item.



Right-click Options:
l Edit Song in Schedule - Allows you to edit a song in the active schedule without saving the changes to the Song
database. See Editing Songs in the Schedule.

l Reset to Automatic Background - Resets a song with an assigned background to the default (auto) background.
l Edit Notes - Use this feature to type in notes for each song. This will only appear in the schedule area. SeeWorking
with Notes in the Schedule

l Add Song to Schedule, Remove from Schedule, Move Up, Move Down all work just as they are defined.
l Add a PowerPoint Presentation - Allows you to browse to your files and add a PowerPoint file to the Schedule
Area. See Using PowerPoint Files



Editing Songs in the Schedule

EasyWorship allows for themodification of songs in the Schedule Area. All aspects of a song can be edited from this area.
Use the following instructions for editing songs in the schedule. When editing a song in the schedule, EasyWorship doesn't
automatically update the database. If you would like the song to be updated in the database and the schedule at the same
time, you can edit the song in the schedule. If you have already created your schedule and want to compare the schedule
to the database, use the Check schedule for Changes feature.

See Building and Running a Schedule and Editing Songs



Using the Schedule

The Schedule Area of EasyWorship is located on the left side of the screen above the Songs, Scriptures andMedia tabs. A
schedule is like a playlist of songs, images, videos, DVD clips and PowerPoint presentations you wish to use in your ser-
vice. You can create your schedule and use it immediately. See Building and Running an EasyWorship Schedule. Or you
can save the schedule for future use on another computer. See Saving Schedules. Once the schedule is built or opened it
is very easy to display the content of that schedule on the projector screen.

1. Create a new schedule or open an existing schedule by clicking the on the toolbar. See Building and Running
an EasyWorship Schedule

2. Select the item in the schedule you want to send to the screen.

3. ClickGoLive .
4. Click on each slide in the Live Area to display the text from that slide on the projector.
5. Notice that thePreview Area now contains a preview for the next item in the schedule.
6. ClickGoLive again to send that song to the projector.





Saving Schedules

Saving A Schedule:
After setting up a schedule, it can be saved for future use.

1. Click on the Filemenu.
2. SelectSave Schedule > Save Schedule as or click theSave icon on the toolbar.

If schedule is being saved for the first time, or if Save Schedule as is selected from the Filemenu, theSave Schedule as
window will appear.

3. Browse to the location on the hard drive that the file is going to be saved.
4. Type in the name of the schedule file in the File name box.
5. Click thePack videos in schedule if you have videos in the schedule that you want to transfer to another com-

puter.
6. ClickSave .

After the file has been saved the first time, clicking the Save icon or select File > Save Schedulewill save the file
without asking where to save the file.

If the file needs to be saved as a different file name or into a new location, select File > Save Schedule as again.



Transferring Schedules

The easiest way tomove presentations from one computer to another is to use the Schedule Area. Simply drag the
desired files into the Schedule Area, save the Schedule as an .ews file, and then re-open the .ews file on the destination
computer.

Transferring a schedule to another computer:

Computer A (Source)
1. On the Source computer, save the schedule you wish to transfer ( .ews file name) on CD, USBmedia or through

your network. Be sure and check Pack Videos if you wish to transfer video backgrounds. For more information
seeTransferring Songs Images and Videos via the Schedule.

Computer B (Destination)
1. On the Destination computer, insert your CD or USB drive.
2. On the topmenu bar, click File.
3. Click onOpen Schedule.
4. TheOpen Schedule window will appear.

5. Select themedia or drive on which you saved the .ews file.
6. Select the file and clickOpen.
7. The Update Local Computer window may appear. This window will allow you to update songs in the database with

the songs in the schedule, or import new songs in the schedule into the database.
8. If there are any errors in the schedule another window will appear, allowing you to resolve the problem.

Notes
To check schedule for changes, see Check schedule for Changes
For transferring the entire song database to another computer, see Backing up your Database
To check schedule for errors, seeCheck Schedule for Errors





Check schedule for Changes

EasyWorship allows you to use all of the content in a schedule on any other computer that has EasyWorship installed. This
is useful for updating songs in the database with new lyrics or backgrounds and transferring videos, images and Power-
Point files from one computer to another in one schedule file. When EasyWorship detects new or changed content in the
schedule, it will allow you to import that content. EasyWorship will automatically check the schedule for changeswhen it
opens the schedule. This can also be amanual process.

1. On the topmenu bar, click Schedule.

2. Click on Check Schedule for Changes.
3. The Update Local Computer window appears.



3. When each item in the list is selected, EasyWorship will allow you to do the following:

l Compare button - The compare button will
appear if you have a song in the schedule that
has the same name, but has different attrib-
utes than what is already in the database. Use
the Compare feature to view the song from the
schedule and from the database side by side.
This will allow you to pick which song you want
to use.

l Select Do Nothing - Ignore this song item if you want to use the item in this schedule only without
updating the EasyWorship database.



l Select Insert - Add the song to the song database
to add a new song to the song database.

Choose to use only the song lyrics or backgrounds or
both.

l Click the Apply to All button at the bottom right to duplicate the same settings for all items like the item selected.
l Select Import - Add this (video, image, present-
ation ) as a (media, PowerPoint) resource to
import a video, image or PowerPoint presentation
into theMedia Resource Area.

Images, Videos, Audio Files, or PowerPoint files imported will be saved to the following location:
WindowsXP: C:\Documents and Settings\All Users\Shared Documents\Softouch\EasyWorship\Profile Folder-
\Resources
WindowsVista & 7: C:\Users\Public\Public Documents\Softouch\EasyWorship\Profile Folder\Resources
Videos: \Videos
Audio: \Audio
Images: \Images
PowerPoint: \Presentations



Notes
If EasyWorship doesn't automatically check schedule for changeswhen they are opened follow the instructions
below.

1. Open a schedule with items in it that don't match the database. Or create an item in the schedule that doesn't
match what is in the database.

2. Click on the Schedulemenu.
3. Click on Check Schedule for Changes...
4. Click the box at the bottom byShow this window when a schedule is opened.
5. Click Finish.



Import a Schedule Saved into an Active Schedule

EasyWorship allows you tomerge two or more schedules into one schedule.

With songs and items already in a schedule, or after opening a saved .ews schedule file, follow these steps.
1. From themenu bar, select File > Import Schedule.

3. Browse to select the .ews schedule file you wish to import.
4. ClickOpen.
5. The newly imported items from the schedule will now be added to the bottom of the current schedule. Youmay save

and rename this newlymerged schedule.



Notes in the Schedule

You can add notes for your tech team or users that will appear with each item in the Schedule Area.When you hover your
mouse pointer over each item the entire note will appear in the pop up window. These noteswill display just under the item
name in the Schedule Area.

To add a note to a schedule item:
1. Highlight any item in the Schedule Area. Notice

the word <notes> is already present.
2. Right-click and select edit notes. The Notes

field will now contain a blinking cursor.
3. Type your notes. When finished, click outside

the notes field.

Notes
The notes can be saved with that schedule.
They cannot be saved to the database.

Notes Inside a Song:
Notes can be added next to any song tag. See AddNotes In A Song



Check Schedule for Errors

When opening a schedule, EasyWorship checks it to make sure it can access all of the content in that schedule. If it detects
an item that cannot be found, a list of Unresolved schedule itemswill be displayed.When building a schedule you can
manually check the schedule for errors. The following instructionswill help you understand and use the Check Schedule
for Errors feature.

To check for those errors:
1. From themenu bar select Schedule > Check

Schedule for Errors
2. TheOpen Schedule window will appear.
3. Select one of the following options:

Do Nothing - Ignore all schedule itemswith
unresolved properties.
Remove - Delete all schedule items or prop-
erties that cannot be resolved.
Resolve - Correct each schedule item or
property individually.

4. Click Next .

Notes
If you wish to transfer images and videos via the schedule file see Transferring Songs Images and Videos via the
Schedule.



Transferring Files via the Schedule

Pack Videos and Images in Schedule

EasyWorship automatically packs songs, images, DVD clips and PowerPoint slide shows into the schedule, but it
doesn't automatically pack videos into the schedule. When saving a schedule, check Pack videos in schedule on the
Save Schedule As screen.

EasyWorship will then pack the video files into one schedule file, allowing for the transfer of videos from one computer to
another, without having to transfer the video files separately. When opening the schedule on the other computer,
select Import - "Add this video item as amedia resource" at the update local computer screen if you would like a copy of
your video on the hard drive of that computer.

See Check schedule for Changes for more information on importing videos and images into your Media Area from your
schedule.



EasyWorship Doesn't Automatically Check for Changes
If EasyWorship doesn't automatically compare the songs in your schedule with the songs in the database when you open
your schedule. See EasyWorship doesn't automatically check for changes for instructions on how to correct this problem.



Adding Songs

TheNew Song dialog box allows you to add a new song to the Songs Resource Area database by typing it or by importing
it. In addition, you can use commonWindows features such as cut/copy and paste to enter text into EasyWorship.
EasyWorship can import Rich Text, HTML,Word,WindowsWrite, WordPerfect, andWorks for Windows files. You can
also savemiscellaneous text to use in your presentations. Miscellaneous text is saved into the songs database, somake
sure that you name it something that you can easily find (e.g., Misc. Text...).

1. Click the New Song  icon on the toolbar.
2. The New Song dialog box appears.

Typing a song:
1. Type a name for the song in the Title box.
2. Click the desired font and size for the text, and use the toolbar buttons to choose a style, color, and fill effects for the

text. For more information on using the Fill Effects dialog box see Adding Backgrounds.
3. If you want to add a tag (color label) to the slide, right-click in the text box, point to Insert Song Tag, and then click

one of the tag types. The desired tag appears in the text box.
l EasyWorship will automatically recognize the song tag when it is typed in and will color code it for you.
l Notes can also be added to the song tag. See Notes Inside a Song

4. Type the lyrics for the song in the Text box.
6. To add a new slide, either insert another tag in the text box, or press ENTER.

l If you want to place blank lineswithin a slide, press SHIFT+ENTER.
7. ClickOK when you are satisfied with the song.

Importing a song or text:

1. Click the Import icon.
2. Browse to the desired file.
3. ClickOK when you have located the file. The song or text appears in the text boxwhere you can edit and format it.



Notes
l Many of the toolbar buttons have a third state - red. The red state indicates that the default setting has been
overridden and that you have edited the text attributes. To change the text attributes back to the default, click
the Default button, or click the down arrow next to the paint can, and then click Automatic.

l You can also copy and paste the text into the text box.
l EasyWorship has an auto format feature whichmakes the text always fit on the slide. Even if enough lines are
added, the text gets smaller.

l To edit the appearance of song tags: on the Livemenu, clickOptions, click the Songs tab, and then click
Label Color Coding.



Editing Songs

The Editor allows you to edit songs, miscellaneous text, and song information. You can choose to edit songs in the sched-
ule for changes saved to the song only for that schedule and/or you can edit permanent changes for the song in the Song
Resource Area.

Edit a song in the schedule:
1. In the Schedule Area, select the song to be edited
2. Right-click on the song.
3. Click on Edit Song in Schedule.

4. The Song Editor appears.

5. Use the text area as a standard text editor to type in text or change text as needed.
6. Use the toolbar to change the font and size of the text, the style, the color, and the fill effects or background. See

Font Sizing Explained
7. ClickOK when you are satisfied with the song.

Add a new slide:
1. Press enter in the text where the new slide is to be added, and then type the new slide text.



Inserting Song Tags:
1. Right-click in the text boxwhere the new slide will be added.
2. Click on Insert Song Tag.

3. Then select one of the tag types.
4. The tag appears in the text box.
5. Then press enter to type the new song text.

To edit copyright information, author information, etc. See Editing Copyright information under notes.

To edit a song in the database:
1. In the Resource Area, click on the Songs tab.
2. Select the song you wish to edit.
3. Right-click on the song.
4. Click on edit song in the database.

The Editor dialog box appears.
5. Use the toolbar to edit the song text. You can change the font and size of the text, the style, the color, and the fill

effects or background.



See Font Sizing Explained
6. To add a new slide, press enter in the text boxwhere you want to add the slide, and then type the new song text.

-Or-
1. Right-click in the text boxwhere you want to add the slide.
2. Select Insert Song Tag.
3. Then click one of the tag types. The tag appears in the text box.
4. Click in the tag to add additional text to the tag. You can also add parentheses and text. See Notes Inside_a_Song
5. To adjust text, as you type the wordswill automatically fit on the slide and continue to get smalle, unless you break

the verse up by pressing enter (page breaks or slide breaks). You can also add blank lineswhich will decrease the
size of the text by holding down shift and enter.

6. To edit copyright information, author information, etc. see Editing Copyright information.
7. ClickOK when you are satisfied with the song.

See Using the Background Designer in the Song Editor and Using the Background Designer

Notes
l To set global options that are applied to all songs see SongOptions.
l Many of the toolbar buttons have a third state - red. This indicates that the default setting has been overridden and
that you have edited the text attributes. To change the text attributes back to the default, click the Default button or
click the down arrow next to the paint can, and then click Automatic. If you delete or change the actual text, you can
use CTRL+Z to undo the changes.

l EasyWorship uses font sizes differently than other Windows-based applications. EasyWorship font sizes are rel-
ative to the overall size of the slide screen. The text will never be larger than this relative percentage, which allows
you to predetermine font size. Therefore, song text will never appear larger and you can keep the font size con-
sistent. For example, in the New Song dialog box you can type new songs and EasyWorship automatically formats
your slide as you type. You can highlight text and select the desire font height percentage while also decreasing it for
other text on the same slide. For more information, see SongOptions .

l If you need to place a blank line within a slide, press shift+enter. You will notice that more blank lines fill the slide and
cause the text size to decrease.

l Click in the tag to add additional text to the tag.
l To set global options that are applied to all songs, see SongOptions.
l Editing Copyright Information: The CCLI # appears by default. A song is copyrighted, or you can add the copyright
symbol and date to the information in the song editor. Once you have entered the CCLI #, it will automatically appear
in each copyrighted song. To add CCLI #, see Displaying Copyright Information.

* Click the Information icon to display the Song Information dialog box.
* Edit the desired information.
* ClickOK.



Deleting Songs

WARNING: The following procedure permanently deletes the selected song from the EasyWorship songs database.

To delete a song:
1. In the Resource Area, locate the song that you want to delete.
2. Right-click on that song, click Delete Song.

3. Click Yes to permanently delete the song from the songs database.



Font Sizing Explained

EasyWorship uses an auto font sizing feature that makes sure that your text always fits the screen. EasyWorship will use
the largest size font possible to display your songs and scriptures. The following information explains how font sizing works
in EasyWorship.

Desired Font Height Percentage:
EasyWorship sets themaximum size of the font by using the Desired Font Height Percentage tomake sure the text
doesn't get too large. The desired font Height Percentage is set for a percentage of the screen size instead of a point font
size likemost text editing programs.
See Songs Tab for more info on changing the Desired Font Height Percentage.

No Minimum Font Height Percentage:
There is nominimum font size. When you begin to type text into a slide, the text will appear using the Desired Font Height
Percentage. After you reach themaximumnumber characters that can fit on a line using the Desired Font Height Per-
centage, EasyWorship will either wrap the text to the next line or, if wrapping is no longer an option, EasyWorship will
make the text smaller with the addition of more characters.

Example: When you begin to type text into a song, you could be typing at 10%. If you continue to type without cre-
ating new slides, EasyWorship will continue tomake the text smaller. Themore text there is the smaller the text
appears.

Text Size Continuity Within a Song:
By default EasyWorship will make all of the text in a song the same size. In order to accomplish this, EasyWorship looks at
the slide with themost text on it to determine the text size of the rest of the slides. If you put more text on a slide than can fit
using the desired font height percentage, EasyWorship will resize the text to fit. EasyWorship will then use that slide to
determine the text size for the rest of the slides.

All text in a song is sized by the longest line of text in the entire slide set for that song. In the event that you have a line that is
too long, youmay break that line intomultiple lines by pressing enter where the line wraps. If you press ENTER twice it will
send the text after the cursor to a new slide. This will reduce the amount of text on the slide to allow the text to appear lar-
ger. You will notice that the text in all of the slideswill appear larger when that line or slide is split into a new line or slide.

Notes
Auto wrapping can be disabled in Live/Options/Songs tab under Advanced.With auto wrapping turned off, EasyWorship
will automatically start resizing the text when you have reached themaximumamount of text that can fit on a line. You will
have to press ENTER at the end of the line tomake sure the text isn't resized until you have reached themaximumamount
of text for the slide.

Changing Text Size Within a Slide:
Youmay select part of the text in a slide and increase the text size up to the Desired Font Height Percentage. EasyWor-
shipmay have to reduce the size of the other text in the slide in order for the selected text to appear larger. The font size in
the song editor is a proportional size. It makes the selected text look larger by shrinking the size of the other text. If you
select the whole slide and try to increase the size, the size will not change. EasyWorship has alreadymade the text on that
slide as large as it can be for that slide. If this is not the case, youmay need to check other slides in the song.



Importing Songs from SongSelect Lyric Service

CCLI’s SongSelect Lyric Service allows you to download songs from thousands of songs on their web site for a nominal
monthly / yearly fee. This lyric service is provided byChristian Copyright License International. To use CCLI's SongSelect
lyric service, youmust be amember with a valid User ID and Password. If you are not a current member, you can sub-
scribe to this service at http://www.ccli.com.

Downloading Songs from SongSelect Lyric Service:
1. Click the Online tab in the Resource Area.
2. Click the SongSelect tab in the web navigation area.
3. Log in if prompted and click Launch SongSelect.
5. Click on the link for the song that you want to import.
6. When the song lyrics appear, click the Import button at the top right.
7. Click Add to Schedule, if you want the song to be added to the schedule.

8. The Copy Song to EasyWorship dialog boxwill appear.

9. Make any changes you would like, then clickOK to copy the song to EasyWorship.

http://www.ccli.com/


The song is copied to the EasyWorship songs database for later use. To edit the song, see Editing Songs.

Notes
l Youmust be connected to the Internet to download a song fromCCLI's SongSelect Lyric Service. See Internet Con-
nectivity under Troubleshooting if you are unable to access SongSelect fromEasyWorship.

l Youmust have a CCLI License and SongSelect Subscription to use this feature. Go to www.ccli.com to find out
how to get an account.

http://www.ccli.com/


No Songs Or Backgrounds in My New Install

If you did not load the demo songs, see Adding and Removing DemoData



Reporting and Printing Songs

EasyWorship allows you to track and generate the usage of songs for reporting andmanaging your library of songs. For
information on reporting the usage of songs, please contact Christian Copyright License Int'l. (CCLI) at www.CCLI.com.
EasyWorship also will print the list of the songs in your Songs Resource Area database. Each time you add, print or pro-
ject a song, EasyWorship tracks that action and stores it for you in a viewable and printable file.

Printing a Song Activity Report:
1. From themenu bar, select File > Print.
2. A sidemenuwill appear, click Print a Song Activity Report.
3. The Select Report Period window will appear. Enter the report period dates for which you need an activity report.
4. The report will appear and you can navigate the topmenu bar for options on saving, printing, etc.

Printing a Song List Report:
1. From themenu bar, select File > Print > Print a Song List Report.
2. The song list will appear showing the numeric and alphabetical listing of the songs in your song database. You can

navigate the topmenu bar options for printing, saving etc.

Printing a Schedule:
You can print the schedule you have saved. This is helpful to pass out to your staff so all can see the agenda for each
presentation. You can print the schedule in both views, either details or summary view.

Printing Schedule (details)
1. From themenu bar, select File > Print > Print Schedule (details).
2. Each song or item in the schedule will be available for printing, page by page, including all the words

on each slide of that song, and the song information of copyrights, author, etc.
3. Navigate the topmenu bar for options in printing and saving the detailed schedule report.
4. The report is saved in a proprietary form called a *.qrp file.

Printing Schedule (summary)
1. From themenu bar, select File > Print > Print Schedule (summary).
2. Each song or item in the schedule will be available for printing, only by file name as it appears in the schedule.
3. Navigate the topmenu bar for options in printing and saving the detailed schedule report.
4. The report is saved in a proprietary form called a *.qrp file.

Using .qrp files:
The qrp files can be opened using EasyWorship.

1. From themenu bar, select File > Print > Song List Report.
2. Click the Load Report button at the top of the report screen.
3. Browse to the .qrp file saved fromEasyWorship.
4. Select it and clickOpen.

http://www.ccli.com/


Text Over Video

EasyWorship layers text over video, images, colors, gradients and feeds.

Using Text Over Video:
1. In the Resource Area, click the Songs tab.
2. Click on the title of the song; it will be highlighted.
3. Click on the Background button above the Preview Area. The palette of background thumbnails will appear. Click a

video thumbnail . (See Adding Backgrounds)
4. Click the Go Live button and the song will appear layered over the video.

l Youmay also attach a video background to a song in the song database. (See How Do I Save A Background
to a Song?)

l Attach a video from theMedia tab or Background palette by dragging and dropping to a song in the schedule,
changing it for that schedule only.

Notes
DirectX is required for EasyWorship to display text over video. Select Help > DirectX Troubleshooting to verify that Dir-
ectX is enabled.

See Text Over Video Troubleshooting under Troubleshooting, If you are having problemswith Text Over Video.



Working with Songs

EasyWorship songs are saved in the Song Resource Area for easy retrieval and efficient songmanagement. You can
search for songs by title or by the first line of any slide, verse or chorus. The Favorites button enables you to select songs
that you use themost and need to access quickly. When clicking the Favorites button only the selected songswill appear.

EasyWorship allows you to import songs, type your own songs or text, and edit songs. You can also download songs from
CCLI's Song Select Lyric Service.

Locate and display a song:

1. In theResource Area, click theSongs
tab.

2. Type the name of the song in the Title
box.

3. Begin typing the name of the desired
song. You only have to type enough char-
acters for EasyWorship to locate the
song.
For example, to locate AmazingGrace,
type "Am".

-Or-
l If you do not know the title, begin typing
the first line of the slide, verse, or chorus
in the Search box.
For example, to find AmazingGrace,
you could type "TwasGrace that" in the
Search box.

l EasyWorship locates, highlights, and dis-
plays the chosen song in thePreview
Area. The first line of the selected verse
is displayed in the Search box.

Notes
EasyWorship reads numbers first, for example, if you name a song "1 AmazingGrace" it will appear first in the
Resource Area. This allows you to type a number and enter if you want to list songs numerically.

l After you locate the desired song, add the song to the schedule. See Building and Running an EasyWorship
Schedule

-Or-
l Click on the Background button and select a background from the thumbnails, then clickGo Live or, double-
click the song to send it directly to the Live Output Area and immediately display it to the congregation.

Notes
To display text over video, the video thumbnails in the Background palette will have film strip edges. You can click on a
song, then the video background thumbnail and then clickGo Live .To save a video as a background to a song to be
used each time you view the song from the database, see Assign Background to song.



Follow along with the singer:

l Click on each verse in the Live Area and follow your leader. You can click the verses in any order.
-Or-

l Use the up and down arrow keys to follow through the verses.
-Or-

l Type 1 and press the enter key, 2 and the enter key, etc., as they correspond to the verses 1-8; 9, 0, C cor-
responds to the chorus; T for Tag; E for End; B for Bridge; and S for slide. There is a small down arrow at the top
right of the Live Area. Click it and drop down the choice to see songs displayed in summary or full view. The num-
bers correspond to the slide in the summary view.

Right-click Features on Songs:

l Edit Song in Database - allows you to
edit the song and save it that way in the
song database.

l New Song - opens the new song editor
window for typing a new song.

See Adding Songs

Adding Songs to the Favorites List:
1. Click on the Songs tab.
2. Click in the second column next to the song you want to add to the Favorites list.

3. When you click the Favorites tab you will see a list of just the songs you selected.



To add new songs see Adding Songs, Editing Songs, Downloading Songs from the CCLI SongSelect Lyric Service



How Do I Use The Favorites Button?

See Adding Songs to the Favorites List



Using the Background Designer in the Song Editor

The Background Designer can be utilized from the Song Editor. This will allow for more control over how text is displayed
on the screen.

1. In the Song Editor, click on the Background button.

2. Select Background Designer.

* From the Background Designer, the font formatting, location and size of the text box , vertical and horizontal text align-
ment can be changed.
See Using the Background Designer for more information on how the background designer works.

Notes
This will not update the thumbnail in the Backgrounds palette. That must be done from the Backgrounds button in the Pre-
view Area.
The text box formatting is attached to the background of the song. When the background for the song is changed, the text
box settingswill be reset.



Text Box Resizing in the Song Editor

You can also adjust the text box in a background by clicking on the thumbnail picture in the Song Editor.

To resize a text box on a background:
In the Song Editor:

1. Click on the song preview area to the right of the text area.
2. Resizing handleswill appear.

3. Resize andmove the text box to the desired location in the preview area.

.



l If you wish to have less text in the box, you will need to separate lines and text in the Song Editor using ENTER. (   
SeeWorking with Songs.)

Notes
The text box formatting is attached to the background of the song. When the background for the song is changed, the text
box settingswill be reset.



Creating Congregational Prompts

1. Edit or create a new song.
2. Select all of the text in the song and set the text size, e.g. 30%.
3. In the Song Editor press SHIFT+ENTER to create spacing between the song text and the prompt.
4. Type in the prompt, e.g., a prompt for offertory.
5. Select the prompt text and set lower the size of it. Use the up and down arrow buttons next to the font size to

increase or decrease the font size.
6. Copy and paste the prompt onto the slides you wish to use it on.
7. Select the prompt text and set the color you wish to use.
8. ClickOK.

Notes
If you don't want these changes to be permanent, make the changes to the song in the schedule and not the database.
Font sizing can be different for each computer depending on the screen resolution being used for the output screen. Use a
custom position that matches the output screen at your church, and the text will always show up the same.



Import PowerPoint Text Into the Database
Save PowerPoint as Outline/RTF file

1. Open your PowerPoint file in PowerPoint.
2. Select File >Save as.
3. In the Save as box, select the Outline/RTF file format at the bottom.
4. Click Save.

Import the RTF Into EasyWorship

1. Open EasyWorship.
2. On the toolbar, click the New Song icon.

3. In the Song Editor next to the song title click the Open Folder icon.
4. Browse to the .rtf file you saved.
5. Select the file and clickOpen.
6. ClickOK on the song to save the song to the database.

Note
l Not all PowerPoint files aremade the same, so thismay not work for all PowerPoint files.
l Youmaywant to select all of the text in the song and click on Reset Attributes to reset the text attributes to default.



Adding More Bible Versions

EasyWorship offersmany free and copyrighted bibles. Bibles can be purchased via theMedia Store tab or by calling us at
+1-918-250-1493. If EasyWorship was purchased via a dealer please contact them to purchase. After the bible is pur-
chased, we will send a new serial number to you via e-mail.

Purchasing a Bible:

1. Open EasyWorship, click the Online tab.
2. Click Login at the top right of theMedia Store page, then log in to the EasyWorshipMedia Store.
3. Click the Bibles tab at the top of the page.
4. Click Add to Cart next to any bibles you wish to purchase.

Clicking Download will download and install the bible text, but the bible will not appear as a tab under the Scriptures
tab unless it is a free bible. Purchased bibles have to be activated with a serial number.

5. Click on Proceed to checkout in the cart.

6. After checking out, the bibles you purchased be activated in EasyWorship on this computer.
7. Check your email for the new serial number that will activate the bible on any other computers youmay have.

Activating A Purchased Bible:

1. Open EasyWorship.
2. Click the Help menu.
3. Select Register Products.
3. In the Serial Number field type in the new serial number.
4. Click Validate.



5. The Validate button will gray out.
6. Click Close.
7. Click on the Scriptures tab.
8. The tab for your new bible will show up at the bottom of the Scriptures Area.
9. If themessage This version of the bible is not installed appears, click download and install it now.
l If you do not have an internet connection, youmay download the text from our web site onto a computer that has
internet access and install the bible text manually. See Installing Bible Text Manually

Installing Bible Text Using the Media Store:

1. Click on theOnline tab in the Resource Area.
2. Click theMedia Store tab.
3. Click on Bibles.
4. Click Download next to the scripture you wish to install.
5. The scripture will download and install automatically.
l If you haven't purchased the scripture yet, click Add To Cart and go through the checkout process.

Installing Bible Text Manually:
1. At a computer with internet connection, browse to

http://www.easyworship.com/bibles.
2. Click on the download link for the bible you want to

download.
3. Save the file to a disk.
4. Take the disk to the computer you want to install

the bible on.
5. Click the Scriptures tab.
6. Click the button to the right of the bible ver-

sion tabs.
7. Click Install Bibles From Disk.

http://www.easyworship.com/bibles


8. Browse to and select the bible file
you saved to the disk.

9. ClickOpen.
10. Follow the steps under Activ-

ating A Purchased Bible from
above.

11. The scripture text will now
appear.



Enabling Scripture Version Tabs

Notes
Not all scriptures are free. See AddingMore Bible Versions for info on how to purchase or add new bibles to EasyWorship.

Enabling Bible Version Tabs:
1. Click on the Scriptures tab in the Resource Area.
2. Notice the bible version tabs at the bottom.
3. To the right of the version tabs, click on the button. The available version tab nameswill appear.
4. Select the versions you wish to enable.



The Scriptures Tab

There are several bible versions resident in EasyWorship to be used in your presentations. You can easily locate and dis-
play chapters and verses from any book of the bible from the Scriptures tab.

The Scriptures Resource Area automatically contains the HCSB, ASV, KJV & RVA bibles. Other versions are available.
Not all version s are free. See AddingMore Bible Versions for more info on addingmore bibles to EasyWorship. For an
updated list of available bibles, go to https://easyworship.com/software/bibles

See Enabling Scripture Version Tabs and Using Scriptures

http://www.easyworship.com/


Using Scriptures

Add a scripture to your schedule:
1. Click on the Scriptures tab in the Resource Area.
2. Click the tab of the bible version you want to use.
3. Type the scripture reference in the Scripture field at the top of the Scriptures tab.

l For example, if you are looking up a scripture in 1 Thessalonians, you would type 1 The. EasyWorship will
then auto-complete the book name for you.

l  Press the right arrow key then type in the verse address in the following format 1:3-5.

4. Click the green plus sign on the schedule toolbar or drag and drop the selected scripture to the Schedule Area.

Notes
When selectingmultiple scriptures, the scripture text will be added to one slide. Editing of the scripturemay be needed.

Using Scripture on the Fly:
1. Click on the Scriptures tab in the Resource Area.
2. Select the bible version you want to use.
3. Type the scripture reference in the Scripture field at the top of the Scriptures tab.
4. Double-click the selected scripture tomake it Go Live.

Editing Scriptures:
1. Right-click on a scripture in the schedule.

2. Click on Edit Scripture in Schedule.
3. Make the changes you need using the Scripture Editor. (The Scripture Editor works the same as the Song Editor)

See Editing Songs for more info on formatting your scripture text.



Using Non-Consecutive Scriptures:
Youmaywant to usemultiple non-consecutive scriptures such asGenesis 1:1-5 and 1:11-15.
You can add each set of scriptures to the schedule separately.
This can also be accomplished without having to addmultiple scriptures to the schedule.

1. Add verses 1-5 to the schedule.
2. Select verses 11-13 in the scripture look up area.

l Youmay type the reference in or hold down SHIFT and select the scriptures.
3. Right-click on the highlighted text and click on Copy Text to Clipboard.

4. Right-click on the scripture in the schedule and edit it.
5. Paste the text into the Editor.
6. Remove the scripture reference at the beginning of the pasted text and the bible version information at the end of the

text.
7. Press ENTER where you want the text to be broken into slides.

8. Change the title to Genesis 1:1-5, 11-13.
9. ClickOK.



Installing Sample Media
When you purchase EasyWorship 2009 you have access to pre-selected freemedia that can be downloaded through the
Media Store within EasyWorship. Follow the instructions below to download the samplemedia that comeswith EasyWor-
ship 2009.

1. Open EasyWorship.
2. Click theOnline tab.
3. On theMedia Store tab click Login.
4. At theAccount Login screen enter your email address and password, then clickLogin.
5. TheMy Downloads page will appear.
6. Click theWMV button next to each video and the JPG button next to each image.
7. The download progresswill appear in theStore Downloads area to the left.
8. After eachmedia file has downloaded, you can find it under theMedia tab.

Notes:
l When logging in, use the email address and password you used when you purchased the software. If you pur-
chased over the phone or through one of our dealers, select First Time Here. Enter your email address and click
Proceed. The email address you use when creating amedia store account must also be listed as a contact on the
account that purchased EasyWorship in order to access the samplemedia.

l Youmay email support@easyworship.com if you need help with your account.
l Media files are downloaded to the EasyWorship profile you are currently using. The default download location is:

XP - C:\Documents and Settings\All Users\Shared Documents\Softouch\EasyWorship\Default\Resources
Vista - 7 - C:\Users\Public\Public Documents\Softouch\EasyWorship\Default\Resources

SeeAdding Backgrounds if you would like to use free samplemedia for backgrounds.

mailto:support@easyworship.com


Setting the Aspect Ratio for Image, Video, Feed & Background

The aspect ratio for images, backgrounds and feeds can now be changed.

What is Aspect Ratio?

Aspect Ratio refers to the ratio of width to height of a picture. This term ismost commonly used with working with video out-
put. Standard definition projectors, televisions and computer monitors use a 4:3 aspect ratio which looks like a square.
High definition projectors, televisions and computer monitors use a 16:9 aspect ratio which looks like a rectangle.

Aspect Ratio Settings Definitions for EasyWorship:

l Automatic - Maintains the original aspect ratio of an image, video or feed by default, but automatically stretches it to
fit the screen when used as a background for text.

l Maintain - Maintains the original aspect ratio of the video, image, feed regardless of use.
l Stretch - Stretches the video, image or feed fit the screen regardless of use.
l Zoom - Zooms in on the video, image or feed cropping the edges regardless of use.

Setting Image, Feed and Video Aspect Ratio:

1. Right-click on an image, feed or video.
2. Select the Set Aspect Ratio option. The options available are Automatic, Maintain, Stretch or Zoom.

Setting the Aspect Ratio on a Song Background:

1. Right-click on a song in the schedule.
2. Select Set Aspect Ratio. The same optionswill be available aswith images, videos and feeds.

Note: The Set Aspect Ratio option will not be available if a background has not been assigned to the song and the
thumbnail has the word Auto on it.

Setting the Aspect Ratio on a background in the Background Database:

This allows you to use a specific aspect ratio each time you use a specific background.
1. Click on the Background button.
2. Click onOptions.
3. Select the background you want to modify.
4. Click theModify button.
5. Select the aspect ratio from the drop down list.
6. ClickOK.



Codecs Explained

What is a codec?
Codec - (enCOder/DECoder or COmpressor/DECompressor) - software (or hardware) that compresses and decom-
presses audio and video data streams.

The purpose of codecs is to reduce the size of digital audio samples and video frames in order to speed up transmission
and save storage space.

l For more information go to http://www.free-codecs.com/guides/What_you_need_to_know_about_codecs.htm

When you play a video or sound file through EasyWorship, it has to know how to decode that file. A codec is a piece of soft-
ware that tells EasyWorship how to decode the video or audio file. If you don't have the proper codec installed on your com-
puter, EasyWorship won't be able to play your multi-media file.

l Standard codecs that are included automatically inWindowsMedia Player are :
Video: Mpeg1, AVI, WMV
Audio: MP3,WAV,WMA
EasyWorship can use any of these types of files without installing extra codec software.

l EasyWorship can playmany other types of files as long as you have a codec for EasyWorship to decode the file with.
Mpeg2, Mpeg4, Divx, Mov files require extra codec software.

l Avoid downloading codec packs that claim to have a codec for every type of file. Many times theywill install software
that conflicts with EasyWorship and can cause your media files to play incorrectly. The only codec packwe current
recommend is the K-Lite codec pack. See K-Lite Codec Pack.

l We recommend FFDShow, Gabest, DScaler or PowerDVD6 or 7 codecs for playingMpg2 files and DVDs. See
RecommendedDVD &Mpg2Decoders

http://www.free-codecs.com/guides/What_you_need_to_know_about_codecs.htm
https://support.easyworship.com/support/solutions/articles/6000015276-k-lite-codec-pack-play-mov-mp4-and-flv-files-ew-2009-


Organizing Images and Videos

To organize images and videos in folders:
1. Browse to Your Profile > Resources > Videos or Images. See Locating Your Profile Data
2. Create any folders you would like to create.
3. Copy your images or videos into any of the folders you would like.
4. In the Resource Area, click theMedia tab.
5. Click on the Images or Videos tab.

6. Click on the folders button at the top right.
7. Select the folders of images or videos you wish to display as thumbnails in the videos palette, and clickOK.

8. Thumbnails for the data in that folder appear in theMedia area.

Notes
If you add images or videoswhen displaying a folder, it will cause the image or video you added to be added to the folder
you are currently viewing. 



Playing Quicktime Files In EasyWorship

Natively, EasyWorship andWindows don't support Quicktime files. However, with the proper video codecs installed,
EasyWorship will playmost Quicktime files. This Codec packwill allow you to playMp4, H.264 andmost Mov files along
with FLV files.
See Installing the K-Lite Codec Pack on the online Knowledge Base.

http://www.easyworship.com/support/kb/index.php?ToDo=view&questId=80&catId=9
http://www.easyworship.com/support/kb/


Using Audio Files
EasyWorship is able to play audio files from your schedule. The following formats are supported by EasyWorship: MP3,
WAV,WMA,MID, AAC. Audio content can be accessed by clicking theMedia tab, then the Audio tab.

Adding Audio Files:
1. Open EasyWorship.
2. Click theMedia tab.
3. Click the Audio Tab.
4. Click the Add button.
5. Browse to and select the audio files you wish to add.
6. Click the Open button.

Playing Audio Files:
1. Open EasyWorship.
2. Click theMedia tab.
3. Click the Audio tab.
4. Drag and drop an audio file into the schedule area.
5. ClickGo Live to play the audio.

l Audio filesmay also be played from the preview column.

Attach Audio To A Song:
1. Open EasyWorship.
2. Add a song to the schedule. See Building and Running an EasyWorship Schedule
3. Click theMedia tab.
4. Click the Audio tab.
5. Drag and drop an audio file from the Audio tab onto a song in the schedule.

Notes
Songsmust be added to the schedule before audio can be attached to them.



DVDs Explained

EasyWorship enables you to utilize the on board DVD ROMdrive on your presentation computer for displaying DVDs or
portions you create as clips. This is a different application of displaying DVD than capturing a DVD feed through a capture
card (SeeWorking with Feeds)

DVD Structure

The video content in a DVD is divided into titles andmenus. Titles are further divided into units called parts of titles (PTTs).
More often, these are called scenes, chapters or segments. These could be compared to using folders and sub-folders in
your directory tree structure of a computer. The viewer can navigate to specific titles or chapters within titles. Each indi-
vidually separated video file on a DVD may be referred to as a segment.

The author of a DVD decides how to divide the content into titles and chapters. When a DVD contains a feature-length film,
the entire film is often placed in one title or segment, and sometimes divided into chapters for the individual scenes. Extra
features on the DVD, such as trailers or deleted scenes, are placed in separate titles or segments. However, these divi-
sions are arbitrary, andmanyDVDs are organized differently.

The EasyWorship DVD editor can play the entire movie, predefined segments or you can select parts of the DVD called
clips. Predefined Clips are segments that you can choose when loading a DVD and those segments will automatically be
readywith the proper Mark In andMarkOut points. For example, if you load an i-Worship type DVD, all the songswould be
predefined and load into the database area when you select Predefined Clips. On anyDVD, youmay set Mark In andMark
Out points to edit a clip. Youmay define a clip name for that edited clip. The DVD fromwhich you wish to play a clip must
remain in the DVD ROMdrive. EasyWorship does not copy the DVD or segments, only a path to turn on that selected seg-
ment or clip. If you havemultiple drives, EasyWorship will remember the drive fromwhich you edited your specific clip. Mul-
tiple clips or segmentsmay be chosen from your DVD.

EasyWorship requires a DVD Decoder to be installed in order to create and play DVD clips. See RecommendedDVD
Decoders for more information.

See DVD Clip Editor Overview, To play a DVD (wholemovie at once), To edit and play a DVD clip (a small piece of a
movie) and To playDVD (Predefined Clips) for help with creating DVD clips in EasyWorship.



DVD Region

In order to create DVD clips in EasyWorship, the DVD region has to be set on the DVD player in the computer. ManyDVD
drives come from the factory with no region set. If the wrong region or no region is set, you will be able to create clips, but
will not be able to play them back after removing and reinserting the DVD into the drive. Follow the instructions below to
set the region on the DVD drive in the computer.

1. Open Computer or My Computer.
2. Right-click the DVD drive.
3. Click Properties.
4. A Properties window will appear.
5. Click the Hardware tab.
6. Select the DVD drive from the list.
7. Click the Properties button at the bottom.
8. The Properties window for the DVD drive will appear.
9. Windows 7 users click the Changes settings button at the bottom of the General tab.
10. Click the DVD Region tab.
11. Select the appropriate country.
12. ClickOK.

Notes:
The DVD region can only be changed amaximumof 5 times.



DVD Clip Editor Overview

DVD Player Window
1. In the Resource Area, click on theMedia tab, click on the DVD tab.
2. Click on the Add button at the bottom of theMedia Resource window. The Select Clip window will appear.

Clip Name -  Field in which you create a name for your clip.

Thumbnail -  Small picture associated with the clip namewhich will appear in the DVD resource
area.

Set Thumbnail Button - Click this button at the frame you choose for your thumbnail.



Edit Mode - Two choices appear for editing clips: Loop Segment and Continuous Play. Click on the down triangle for
selection. Loop Segment loops only the current segment you are editing. Continuous Play plays the entire DVD allowing
you to edit it.

Title - TheMain Menu or Main Segments of the DVD.

Position - The numerical elapsed time and current location in the DVD. You can increase or decreaseMark In andMark
Out points by navigating the triangles and editing the number fields.

Chapter - Sub-menu segments under each title.

Clip Start - The position at which youMark In the starting point of your edited clip.

Clip End - The position at which youMarkOut the ending point of your edited clip.

Select Segment - Click this button when you wish to select the entire segment you are playing. It will automatically set the
Mark In andMarkOut at its beginning and ending points.

DVD Drive and Name - Displays the name of the DVD and the drive playing. If you havemultiple drives you can click the
down triangle and select additional DVDs.

Disk Name - You can create a disk name to recognize as it appears in the DVD database.



Position Scrolling Ball - A visual tracking of the position of the DVD. It can be scrolled forward and backward to new
locations on the segment.

Edit Mode - Click this button to edit your clips.

Preview Mode - Click this button to preview your edited clip.

DVD Menus - Each DVD will have different menus for displaying the Title, Root,
Subtitles (lyrics), Audio (split tracks, click tracks, Stereo, Surround, etc.),
Angle (the camera angles available), and Chapter Menus.

* For additional instructions see Creating & Managing DVD Clips, Using DVD Clips, Using Predefined Clips



DVD Clip Database Overview

DVD Clips Database Views- In the DVD clip database there are two views available. The All DVD Clips list and the Avail-
able DVD Clips list. All DVD Clips shows a list of all the DVD clips created. Available DVD Clips displays a list of clips cre-
ated for the DVD that is currently in the DVD drive. DVD clips listed under All DVD Clips cannot be edited, but can be
deleted.

Add - When clicked the Select Clip window appears allowing you to create a new DVD clip.

Delete - Removes the selected DVD clip from the DVD clip database.

Edit - When clicked the Select Clip window appears allowing you tomake changes to an existing DVD clip.

Add New DVD Clip... - When clicked the Select Clip window appears allowing you to create a new DVD clip.

Add New From Selected - When clicked creates a copy of the selected clip and loads the Select Clip window allowing you
to create a new DVD clip.



Add/Update Predefined Clips... - Allows you to add DVD clips to the database that have already been created for certain
DVDs.

For additional instructions on how to set up different kinds of DVD clips see Creating & Managing DVD Clips, Using DVD
Clips, Using Predefined Clips



Creating & Managing DVD Clips

Creating DVD Clips:
1. Insert a DVD into the DVD ROMdrive.
2. Click on theMedia tab in the Resource Area.
3. Click on the DVD tab.
4. Click the Add button.

The Select Clip window will appear.
5. Type the clip name in the Clip Name field at the top left.
6. Click the item you want to play in the DVD menu to the right .
7. As video plays, click theMark In button to select the beginning of your clip.
8. Click theMark Out button to select the end of the clip.

Notes
l To play the whole DVD click Select Segment.
l For iWorship DVDs and others like it, youmay click Select Segment when the video starts playing. EasyWor-
ship will set theMark In andMarkOut points at the beginning and end of the song for you.

9. The Preview button will allow you to preview your edited clip in the window. Click the Edit button to resume editing.
10. Scroll the clip to find the frame you wish to use for a thumbnail and click Set Thumbnail.
11. ClickOK. The clip and thumbnail will appear in the DVD clip database.



Editing DVD Clips:
1. Select a clip in the DVD clip database.
2. Click Edit .
3. The Select Clip window will appear, allowing you tomake changes to the DVD clip.
4. ClickOK to apply the changes.

Deleting DVD Clips:
1. Select a clip in the DVD clip database.
2. Click Delete .
3. Click Yes on the prompt that appears to verify that you want to delete the clip.

See DVD Clip Editor Overview, Using DVD Clips, Using Predefined Clips



Using DVD Clips

Using DVD Clips in the Schedule:
1. Select a DVD clip in the DVD clip database.
2. Click the on the Schedule toolbar.
3. When it is time for the DVD clip to be played in the ser-

vice, just clickGo Live .

Notes:
l Youmay also drag and drop a clip from the database to
the schedule.

l Go live with a DVD clip directly from the database by
double-clicking it.

l TheDVD has to be in the drive for the clip to play.
l DVD clips can be transferred via the schedule to another
computer.

l Clips are forward compatible but not backward com-
patible. Clips created onWindows 9xwill work onWin-
dowsXP but clips created on XP will not work on 9x.

l Clips created onWindows 9x-XP will not work onWin-
dowsVista-7 and vise versa.

See DVD Clip Editor Overview and Creating & Managing DVD Clips



Using Predefined Clips

Predefined clips are predefined with the proper start and stop points already set. This saves you the time of having to edit
each segment to prepare a DVD clip for the DVD clip database. For example, if you have an iWorship type DVD which con-
tains 7 songs, you can select Add/Update Predefined Clips and each of the 7 songswill now appear in the DVD clip data-
base, predefined and ready to play. Not all DVDswill support predefined clips.

Notes
EasyWorship does not copy the electronic image of the DVD. It only creates a bookmark to a location on the DVD accord-
ing to how you edited or saved that clip. You still must have the DVD inserted into the drive to play the clips.

If the DVD has segments that have lyrics on lower, upper, or middle thirds, you can select these predefined clips in that
format. This is also true for split tracks, click tracks and no lyric tracks. If the DVD has those segments, you can now save
the same song in different formats. For example, youmaywish to save the song "Open the Eyes of MyHeart" in upper
thirds, lower thirds, and center. Or upper thirds click track, lower thirds split track. Then when you have a presentation, you
can select the format predefined and ready for projection.

1. Insert a DVD into the DVD ROMdrive.
2. Click on theMedia tab.
3. Click on the DVD tab.
5. Click the drop down triangle on the Add button, then click Add/Update Predefined clips.

6. The Select Predefined DVD Clips window will appear.

7. CheckCheck the internet for the latest clip info if you want EasyWorship to connect to the EasyWorship pre-
defined clip site to check for new or updated DVD clips for this DVD.



8. Check Show this window when a new DVD is inserted to be prompted if there are any predefined clips for a DVD
when it is inserted into the drive.

9. If predefined clips are available, theywill appear in the window.
10. Check the boxes next to types of clips you wish to use.
11. ClickOK.
12. CheckClear any predefined clips that are not selected and have not been edited to clear any predefined clips

already loaded for that DVD. Clips that have not been edited and are not selected in this window will be cleared.
13. The selected predefined clips will now appear in the DVD clip database.

Notes
Predefined DVD clips can be edited by selecting the clip and click the edit button at the bottom of the DVD clip database.
See Creating & Managing DVD Clips



Recommended DVD Decoder

Descaler is the recommended decoder
Download here: https://support.easyworship.com/support/solutions/articles/6000015386-install-dscaler-for-dvd-play-
back-ew-2009

https://support.easyworship.com/support/solutions/articles/6000015386-install-dscaler-for-dvd-playback-ew-2009
https://support.easyworship.com/support/solutions/articles/6000015386-install-dscaler-for-dvd-playback-ew-2009


Using Feeds as Backgrounds

Add a Feed to Backgrounds:
You can add a feed to the Background palette and use it as a live background. The feedmust be added to the Videos
Resource Area to appear in the Add area.

1. Click theMedia tab.
2. Click the Feeds tab.
3. Right-click a feed, then click Add Feed to Backgrounds.
4. The feed is now available in the Background palette.

Tips
l Use the VJ feature for camera switching.
l Add camera feeds to backgrounds, use the background designer to make text appear on the lower third, then use
the VJ feature to switch cameras behind text.

For more details on working with backgrounds see Using Backgrounds and Using Video JockeyMode.



Using Feeds

EasyWorship can project images from your computer through external devices (DVD, VHS, Camera(s), andMixer) using
a capture card. Most capture cards are PCI cards that are installed into PCI slots on themotherboard of your computer.
Each capture card has its own input connections. Some are RCA (composite) jacks, some are S-video, and some are
FireWire IEEE1392. It is important that you determine the type of interface cable desired before you order your capture
card.

Notes
FireWire IEEE1392 has some latency that is noticeable. This optionmay not be desirable if your audience can see the
source and output screen. Some capture cards do not work well with multiple cards of the same type. Please go to the Sys-
temRequirements on www.easyworship.com for a list of suggested cards.

Adding a feed:
1. Open EasyWorship.
2. In the Resource Area, click theMedia tab.
3. Click the Feeds tab.

5. Click Add.
6. The Add Feed dialog box appears with the installed capture cards listed under Available Input Devices.

http://www.easyworship.com/easyworship/techspecs#SystemRequirements
http://www.easyworship.com/easyworship/techspecs#SystemRequirements


7. Click the capture card to which you want to connect the device.
8. Type a name for the device in the Name box.
9. Select the type of device from the Device list.
10. Click Advanced.
11. The Advanced Feed Options dialog box appears.

1. In the Input Device list, click whether you are connecting byComposite or S-video.
2. In the Resolution list, set the resolution to at least 320x240 or 640x480.
3. Leave the Frame Rate at the default setting of 29.97.
4. Leave the Video Standard at the default setting.
5. Leave the Color/Compression at the default setting.
6. Click OK to return to the Add Feed dialog box.

10. ClickOK when you are done.



The added device appears in the Resource Area. To add additional devices repeat steps 1-10.

Deleting Feeds:
1. In the Resource Area, click theMedia tab.
2. Click the Feeds tab.
3. Click the device that you want to delete.
4. Click Delete.
5. A message appears asking you if you want to permanently delete the feed.
6. Click Yes to delete the feed.

Editing Feeds:
1. In the Resource Area, click theMedia tab.
2. Click the Feeds tab.
3. Click the feed that you want to edit.
4. Click Edit.
5. Make the desired changes.
6. ClickOK.



Working with Images

Follow the instructions below to use the images tab.

Adding Images:
EasyWorship comeswith images ready for you to use in your presentations. EasyWorship can import images that you
have produced, or additional images you have purchased.

Notes
EasyWorship will display .bmp, .jpg, .wmf and .ico files. For the best results store all images in Your Profile/images folder.
See Locating Your Profile Data to find out how to located your images folder.

1. Click theMedia tab.
2. Click the Images tab.
3. Click the Add button to access the Add Images dialog box.
4. Locate and highlight the image that you want to import.
5. ClickOpen.
6. The imported image appears in the Images area.

Adding Images From the Media Store in EasyWorship:

1. For installing SampleMedia see Installing SampleMedia
2. For purchasing and downloadingmedia seeMedia Store Tab

Right-click Features:
When you right-click on a thumbnail in the Images Resource Area, you have the following options:

l Add Images - this is a shortcut to adding additional images youmight have on a CD.
l Delete Images - deletes the image from the resource area. It will prompt you to delete it completely from the /
Resources / Images folder.

l Add Image to Schedule - adds image to the schedule.
l Add Image to Backgrounds - allows you to add images to the Backgrounds palette directly from this view.

Drag and Drop Features:
l Add to Schedule - Drag and drop an image into the schedule from the Images tab.
l Use as Background - Drag an image onto a song in the schedule to assign that image to a song as a background.
l Add a New Image - Drag and drop images from any folder in theWindowsOperating System to the Images area.
EasyWorship will then add a shortcut to that image into your Images tab.



Displaying Images
Displaying Images:

In the Resource Area:
1. Click theMedia tab.
2. Click on the Images tab, then drag and drop the image to the Schedule Area.
3. Select the image in the Schedule Area and clickGo Live . Youmay also double-click the image tomake it go to

the Live Area.



Playing Videos
Playing Videos:

1. In the Resource Area, click theMedia tab.
2. Click the Video tab.
3. Drag and drop the video thumbnail to the Schedule Area.
4. Highlight that video and click the Go Live button.

Notes
l When displaying a video the video does not appear in the Live Output Area because it takes excessive amounts of
memory to display the video clip in the Preview and Live Output Areas simultaneously.

l EasyWorship will play files supported byWindowsMedia Player and someQuicktime , MP4 and FLV files if the K-
Lite codec pack is loaded on the computer.

http://www.easyworship.com/support/kb/index.php?ToDo=view&questId=80&catId=9
http://www.easyworship.com/support/kb/index.php?ToDo=view&questId=80&catId=9


Using Videos
EasyWorship can play any video format thatWindow Media Player supports. See Codecs Explained

Adding Videos:
EasyWorship comeswith videos ready for you to use in your presentations. EasyWorship can import videos that you have
produced, or additional videos you have purchased.

In the Resource Area:
1. Click theMedia tab.
2. Click the Videos tab.
3. Click the Add button to access the Add Videos dialog box.
4. Locate and highlight the video that you want to import.
5. ClickOpen.

Adding Videos From the Media Store in EasyWorship:

1. For installing SampleMedia see Installing SampleMedia
2. For purchasing and downloadingmedia seeMedia Store Tab

Deleting Videos:

In the Resource Area:
1. Click theMedia tab.
2. Right-click the video that you want to delete.
3. Click Delete.
4. A message appears asking if you want to permanently delete the video.
5. Click Yes to delete the video.

Select Thumbnail from Video:
Use this feature if EasyWorship doesn't automatically build a thumbnail for one of the videos, or you wish to change the
thumbnail that was automatically build.

In the Resource Area:
1. Click themedia tab.
2. Right-click a video you wish to select the thumbnail for.
3. Click Select Thumbnail from Video.
4. Drag the slider bar to the frame you wish to display as the thumbnail in your videos palette.

The thumbnail for the video will change as you drag the slider.

5. Click away from the select thumbnail box to set the thumbnail.



Right-click Features:
When you right-click on a thumbnail in the Videos Resource Area, you now have the following options:

l Add Videos - this is a shortcut to adding additional videos youmight have on a CD.
l Delete the Video - deletes the video from the Resource Area. It will prompt you to delete it completely from Your
Profile > Resources > Videos folder. See Locating Your Profile Data

l Add Video to Schedule - adds video to the schedule.
l Add Video to Backgrounds - allows you to add this video to the Backgrounds palette from this view.
l Select Thumbnail from Video - allows you to preview the video and set the thumbnail for that video.

Drag and Drop Features:
l Add to Schedule - Drag and drop a video into the schedule from the Images tab.
l Use as Background - Drag a video onto a song in the schedule to assign that image to a song as a background.
l Add a New Video - Drag and drop a video from any folder inWindows to the Images Area. EasyWorship will then
add a shortcut to that video into your Images tab.

Notes
l Store your videos in the following location on your hard drive: Your Profile > Resources > Videos. At this point you
maywish to create sub-folders to better categorize your collection. See Locating Your Profile Data. See How Can I
Organize Images and Videos?

l You can also copy and paste new videos into: Your Profile > Resources > Videos and theywill appear in the
Media Area automatically.

See How do Videos, Images & BackgroundsWork? and Codecs Explained under media if you are having problemswith
videos.



Online Content

EasyWorship allows you to schedule online content to be displayed during a presentation. Clicking theOnline tab in the
Resource Area unlocks EasyWorship's online options.When clicking theOnline tab, you will notice that the Preview and
Live Areas are now replaced with a web browser with three tabs at the top left. TheMedia Store tab allows you to pur-
chase and downloadmedia and bibles directly to EasyWorship. The SongSelect tab allows you to import lyrics via the
SongSelect lyric service. This allows you to keep SongSelect open and available at all times for quick access. TheWeb
tab allows you to add web sites to the schedule to be displayed during a presentation. TheWeb tab also allows you to
schedule Flash content and YouTube videos.

SeeMedia Store Tab, SongSelect Tab, and Web Tab for more information.



Media Store Tab

Using themedia store built into EasyWorship will help simplify the process of purchasing and addingmedia to EasyWor-
ship. Using themedia store allows you to purchase, download and displaymedia quickly.

Using the Media Store Tab:
1. Click the Online tab in the resource area.
2. Click theMedia Store tab at the top left of the web browser area to the right.
3. Browse themedia store and add videos, images or bibles to your cart.
4. After you check out, links will be provided to download the items you have purchased.
5. Click the links to start the download process.
6. During the download process, the itemswill appear in the Online tab as Store Downloadswith the progress shown

underneath.
7. The videos and imageswill automatically appear in their respective tabs under theMedia tab.
8. Bibles will install automatically. Free bibles will appear immediately in the Scriptures tab. Purchased bibles require

you to enter the new serial number you received via email. See Installing Bible Text Using theMedia Store



SongSelect Tab

See Importing Songs fromSongSelect



Web Tab

Using the Web Tab:
1. Click the Online tab.
2. Click theWeb tab.
3. Type the web address into the address bar and press ENTER.
4. Click the Schedule button to add that web page to the schedule.

Playing YouTube Content:

1. Click the Online tab.
2. Click theWeb tab.
3. Type in www.youtube.com into the address bar at the top of the window and press enter.
4. Click the video you want to play.
5. When the video appears click the Schedule button at the top right corner of the window.
6. The following prompt will appear,

"Would you like EasyWorship to automatically display this video full screen when you go live?"
If this prompt doesn't appear, the full screen option is not available for this video.

7. Click Yes or No.

Playing Flash Content:
1. Click the Online tab.
2. Click theWeb tab.
3. Type in the address to the flash content and press ENTER.
4. Click the Schedule button.

Playing Flash Content From the Hard Drive:
1. Click the Online tab.
2. Click theWeb tab.
3. Type in the path to the swf or html file in the address bar at the top.
4. Make sure that you type the name of the swf or html file at the end of the path.

Example: C:\FlashFiles\RubberChickenDance\RCD.swf or C:\FlashFiles\RubberChickenDance\index.html
5. Press ENTER.

The flash content should play in the Online Area.
6. Click the Schedule button to add it to the schedule.



Installing Sample Media
When you purchase EasyWorship 2009 you have access to pre-selected freemedia that can be downloaded through the
Media Store within EasyWorship. Follow the instructions below to download the samplemedia that comeswith EasyWor-
ship 2009.

1. Open EasyWorship.
2. Click theOnline tab.
3. On theMedia Store tab click Login.
4. At theAccount Login screen enter your email address and password, then clickLogin.
5. TheMy Downloads page will appear.
6. Click theWMV button next to each video and the JPG button next to each image.
7. The download progresswill appear in theStore Downloads area to the left.
8. After eachmedia file has downloaded, you can find it under theMedia tab.

Notes:
l When logging in, use the email address and password you used when you purchased the software. If you pur-
chased over the phone or through one of our dealers, select First Time Here. Enter your email address and click
Proceed. The email address you use when creating amedia store account must also be listed as a contact on the
account that purchased EasyWorship in order to access the samplemedia.

l Youmay email support@easyworship.com if you need help with your account.
l Media files are downloaded to the EasyWorship profile you are currently using. The default download location is:

XP - C:\Documents and Settings\All Users\Shared Documents\Softouch\EasyWorship\Default\Resources
Vista - 7 - C:\Users\Public\Public Documents\Softouch\EasyWorship\Default\Resources

SeeAdding Backgrounds if you would like to use free samplemedia for backgrounds.

mailto:support@easyworship.com


Adding Backgrounds

Adding Backgrounds
EasyWorship allows you to choose backgrounds for your songs and scriptures. Backgrounds can be gradients, colors, pic-
tures, videos, or live feeds. You can also customize your backgrounds using the Background Designer. EasyWorship
comes standard with backgrounds, but youmaywish to add others also. TheOptions button in the Background Options
dialog box allows you to add, remove, modify, and customize backgrounds.

Adding multiple backgrounds to the background palette:
1. Click the Background button.
2. Click Options.
3. Click Add Multiple.
4. Browse to and select the videos or

images to be added.
5. Click Open.

The selected pictures / videos appear in the Back-
ground palette.

Adding a single background to the background palette:
1. Click the Background button.
2. ClickOptions.
3. Click Add.

The Fill Effects dialog box appears with five tabs

Adding a color background:
1. Click the Color tab to choose a color from the color

palette, or click Custom Color to select a solid
color background.

2. ClickOK to add that color to the background
palette.



Adding a gradient background:
1. Click the Gradient tab to choose the desired color

from the Color 1 and Color 2 lists.
2. Click the desired Shading Style. The Variants

boxes allows for previewing the gradient.
3. Click the desired variant and clickOK.

Adding an Image background:
1. Click the Picture
2. Click Browse to add an image background.
3. Browse to the image to be added.
4. Select the image file.
5. ClickOpen.
6. The selected picture appears with its path dis-

played below it.
The image can be tiled by clicking Tile Image.



Adding a Video background:
1. Click the Video tab to add a video background.
2. Click the Browse button.
3. Browse to the video to be added.
4. Select the video file.
5. ClickOpen.
6. Use the video controls in the Video tab to preview

the video.
7. Use the Set Thumbnail button to set a different

thumbnail for the video.
8. ClickOK.

Adding a Feed background:
1. Click the Feed tab to add a feed background.
2. Select a feed.
3. ClickOK.

SeeWorking with Feeds for more information
about using feeds as backgrounds.

Removing a background:
1. Click on the Background button.
2. Click onOptions.
3. Select the background to be removed.
4. Click the Delete button.
5. Click the Yes button to remove the background



Right-click Features:
l Assign a background to the Logo button by select-
ing Set as Logo.

l Set background for Foldback screen by selecting
Set as Foldback

l Move a background up and down in the Back-
ground palette by selectingMove Item Up or
Move Item Down.

l Add a single background to the Background
palette by selecting Add...

l Add a single background to the Background
palette by selecting Add Multiple...

l Modify a background by selectingModify...
l Remove a background by selecting Remove.

Right-clicking a thumbnail in the Videos, Images or Feeds Resource Area displays amenu to:
Add a Video, Image or Feeds to Backgrounds - allows you to add this video to the Background palette from this view.



Background Options

TheOptions button in the Background Options dialog box allows you to add, remove, modify, and customize back-
grounds.

See Adding Backgrounds, Using the Background Designer andModifying Backgrounds

Right-click Features:
l Assign a background to the Logo button by selecting Set as Logo.
l Move a background up and down in the Background palette by selectingMove Item Up or Move Item Down.
l Add a single background to the Background palette by selecting Add...
l Add a single background to the Background palette by selecting Add Multiple...
l Modify a background by selectingModify...
l Remove a background by selecting Remove.



Editing Backgrounds

Editing a background:
1. Click on the Background button.
2. Click Options.
3. Select the background to bemodified.
4. Click Edit to access the Fill Effects dialog box.

l Set a different frame in a video clip for the thumbnail, using the slider ball under the video window and the Set
Thumbnail button.

l For picture backgrounds, select Tile Picture to tile that background picture when it is displayed.



Using Backgrounds

If a schedule item has the word Auto on it, a background has not been assigned to that song, that song is using the last
background selected under the Background button in the Preview area.

Setting a global background:
1. Click the Background button at the top of the Preview

Area.
2. Click on the background to be used on all songs that don't

have a background assigned to them.

Assign a Background to a Song:
Drag and Drop:

1. Click the Background button at the top
of the Preview Area.

2. Drag and drop the background onto a
song in the schedule.
(This does not update the database.)

In the Song Editor:
1. Create a new song or right-click on a song in the database or schedule and select edit song.
2. In the Song Editor click on the Background button.
3. Select the background to be assigned to that song.
4. ClickOK.

Using a background that is not in the backgrounds list:
1. Click Fill Effects.
2. Select the tab for the type of background you want to use.
3. If you are not using a color or gradient, click the Browse button at the bottom right.



4. Browse to the file or feed you wish to use
5. Select the file or feed and clickOpen
6. ClickOK. The background will now be saved to the song in the Song Resource Area. You can also click the Auto-

matic button to choose the default background for all songs to be applied to this song aswell. No background will be
saved to the song when choosing Automatic. See Adding Backgrounds

7. You can also use Text Box Resizing here in this Editor.
l Click on the picture in the Editor widow. Resizing buttonswill appear.
l Set the size and location of the text box and save to the song.

See Text BoxResizing in the Song Editor



Using Video Jockey (VJ) Mode

Video Jock or VJ is a feature that gives you access toMedia and Backgrounds at your fingertips. When clickingmedia or
backgrounds in theVJ Control Area, the live background will change on the fly as you click. Follow the steps below to
enable and use VJ.

1. Click the down arrow at the top right of the Live Area.
2. SelectVideo Jockey Mode from the list.

3. TheVJ Control Areawill replace the Live Preview Area.

4. Click on any video, image, feed or background.
5. The background on the output screen will change on the fly as you click.



Using the Background Designer

EasyWorship allows for image and video backgrounds to be altered. Backgrounds that are altered using the Background
Designer appear in the background palette with an "A" in the upper left corner.

Before altering an image or video background, create a duplicate so that there will be a copy of the original in the back-
ground palette.

To add a duplicate picture or video:
See Adding Backgrounds

Accessing the Background Designer:
1. In the Background Options window, click the background that you want to customize.
2. Select the Override Global Options for this Background check box.
3. Click the Background Designer button.
4. The Background Designer dialog box appears

Moving and resizing the Text Box:
1. Click on the picture.
2. Resizing handles appear in all corners and in the center of each side of the text box.
3. Resize the frame using the resizing handles.
4. Click and drag the text box to the desired location.
5. ClickOK when all changes are complete.

Using the Formatting Toolbar:



1. Click the Font Name drop down box to select the font to be used.

2. Change the font size percentage using the up and down arrows .
3. Use the B and I buttons to turn on Bold and Italics.
4. Use the S andObuttons to turn on Shadow andOutlining.
5. Click the arrow next to A, S, and Obut-

tons to select the Font, Outline and
Shadow color.

6. Click the button to change the fill
effects.

7. Click the text alignment buttons on the
toolbar to change the vertical and hori-
zontal alignment of the text.

Right-click Features:
1. Right-click the text box.
2. Click on Reset Text Margins to reset the

text box location and size back to default.



Attach A Background To A Song

You can save a background so that it appears with the song each time you select the song from the database.When you
add that song to the schedule, the background will stay attached to the song.

1. Click on a song in the Song Resource Area.
2. Right-click and choose Edit Song.
3. The Edit Song window appears. Click on the Backgrounds button. The images and videos in the background

palette now appear in this Editor window.

4. Select the background of choice.

5. ClickOK.



Using a background that is not listed in your backgrounds list:
1. In the song editor click the background button.
2. Click on Fill Effects.
3. Select the tab for the type of background you want to

use.

4. Click the Select Button at the bot-
tom right.

5. Browse to the file you wish to
use.

6. Select the file and clickOpen.

7. After selecting background andOK. The background will now be saved to the song in the Song Resource Area.
You can also click the Automatic button to choose the default background for all songs to be applied to this song as
well. Actually, no background will be saved to the song when choosing Automatic.



Using PowerPoint 2007 / 2010 Files

Installing PowerPoint Viewer 2010:

Upon the first attempt to use a PowerPoint 2007 or 2010 file, EasyWorship will prompt you to download PowerPoint
Viewer 2010 onto your computer. This will only occur if you do not have Microsoft PowerPoint 2010 Viewer or Microsoft
PowerPoint 2007 / 2010 installed.

1. Click the download.
2. Click the download on the web page that appears.
3. Click Save on the window that appears.
4. Browse to your Desktop and click Save.
5. After the file has downloaded. Open the file and follow theWizard to install PowerPoint Viewer 2010.

Notes
Youmay also start the download of the PowerPoint Viewer by clicking on Help >Install Microsoft PowerPoint Viewer.
Visit www.easyworship.com/support/ and enter PowerPoint in the search bar for related articles.

http://www.microsoft.com/downloads/details.aspx?FamilyID=cb9bf144-1076-4615-9951-294eeb832823&displaylang=en
http://www.easyworship.com/support/kb


Using PowerPoint Files

Microsoft PowerPoint files can easily be integrated into the schedule. Follow the instructions below to add a PowerPoint
slide show to the schedule.

EasyWorship can project a PowerPoint slide show and allow changes to bemade to the schedule without interrupting the
slide show. PowerPoint slide shows can be easily navigated by clicking on the slide you wish to project in the Live Area.
Slide showswith automatic timings and transitionsmay also be used.

If Microsoft PowerPoint is not installed on the computer, EasyWorship will use PowerPoint viewer 2003 to display the slide
show. If PowerPoint 2007 and 2010 files are used, PowerPoint Viewer 2010must be installed on the computer. Youmay
also use the PowerPoint 2007 / 2010 applications aswell. See PowerPoint 2010

To add a PowerPoint file to your presentation: 

1. In the Schedule Area, click on the PowerPoint icon.

The Add PowerPoint Presentation dialog box appears.

2. Locate and select the desired PowerPoint file.
3. ClickOpen
4. The Importing PowerPoint Slides dialog box appears showing the progress.
5. Once the slide show is imported, it will appear in the Schedule Area. Clicking Go Live sends it to the Live Output

Area.



Notes
You can save the schedule and use it to copy or move the PowerPoint file. See Transferring Songs Images and Videos via
the Schedule EasyWorship packs the PowerPoint file into the schedule. When the schedule is opened it will use the ori-
ginal file from the hard drive if it is available. If the original file isn't available it uses the packed PowerPoint in the Schedule.
See Check schedule for Changes for the options available when opening a schedule with a PowerPoint file in it.

Thumbnail Sizing:
1. Click the drop-down arrow at the top right of the Preview Area or the Live Area to

change the size of the slides in that area.
2. Click the Go Live button to automatically display the slides to the congregation; or

double-click a particular slide to display it to the congregation.



Jump In and Out of PowerPoint:
1. While displaying a PowerPoint presentation, click on the

Scriptures tab in the Resource Area
2. Find a scripture, press ENTER or clickGo Live. The scrip-

ture is immediately projected . Then a PowerPoint button
appears at the top of the Live Area.

3. Click the PowerPoint button, the PowerPoint presentation
projects again at the same place you exited to project the
scripture.



PowerPoint on the Foldback Screen

EasyWorship will also display PowerPoint slide shows on the Foldbackmonitor; however, the foldback view provided
more information for the people on the stage than the Front of House screen. On the foldback screen, the PowerPoint
slide will appear like the Front of House, but foldback also has the ability to show the thumbnails of the slides in the present-
ation, allowing people on stage to see what is currently selected along with what the next and previous slides are.

See PowerPoint Options under Display Foldback for a list of options available for displaying PowerPoint on the foldback
screen.



Using PowerPoint Files With Audio & Video

EasyWorship allows you to use PowerPoint Files with Audio and Video in the slide show. The following information will
help youmake sure these files will alwayswork when you use them in EasyWorship.

Method 1: All Versions of PowerPoint
Create the PowerPoint slide show on the presentation computer.
This will make sure that PowerPoint can find all of themedia files it needs to access, when EasyWorship displays it.

Method 2: All Versions of PowerPoint
Making changes to your file organization structures can also helpmake sure audio and video alwaysworks in your Power-
Point slide shows.

1. Create a folder on the root of your C: drive on your computer and the Presentation computer like, "PowerPoints".

2. Inside that folder, create another folder called " audio".



3. Copy the audio files you want to use for your presentation into the audio folder.
4. Add the audio files to your PowerPoint slide show.
5. Save the slide show in the PowerPoints folder. C:\PowerPoints
6. Copy the PowerPoint and audio files fromC:\PowerPoints to a CD or Memory Stick.
7. At the presentation computer, copy the files into the same location on that hard drive. Copy the PowerPoint file to

C:\PowerPoints and audio files to C:\PowerPoints\audio.
8. Add the PowerPoint slide show to your schedule. See Using PowerPoint Files

Notes
The audio folder is not necessary, but helps keep the files tidy.

Method 3: PowerPoint 2003
With PowerPoint 2003 you can use the Package for CD... feature.

1. Create the PowerPoint slide show.
2. Click on File
3. Click Package for CD...



4. Click Copy To folder...

5. Under Folder name type the name of the folder.
6. Click the Browse button.



7. Browse to the folder you want to save the slide show in.
8. Click Select.

7. ClickOK.
8. Click Close.
9. You can now transfer the folder with the presentation and audio files in it to your presentation computer.
10. Add the PowerPoint to your schedule. See Using PowerPoint Files
11. Disable the option to use PowerPoint application instead of viewer. See Use PowerPoint application instead of

Viewer for info on how tomake that change. (You should only have tomake this setting change once)



Creating 16x9 Widescreen Slide Shows
If your projection system projects in a widescreen or 16x9 format, youmay have noticed that PowerPoint slideshows
appear on the screen with black bars on the left and right. In order to make the PowerPoint slide show fill the screen, the
page setup needs to be changed.

1. OpenMicrosoft PowerPoint.
2. In PowerPoint 2007 click the Design tab.
3. In PowerPoint 2003 or older click the File menu.
4. Click Page Setup.
5. In PowerPoint 2007 under Slides sized for: Select On-Screen Show 16x9
6. In PowerPoint 2003 under Slides sized for: Select Custom. SetWidth to 8 and Height to 4.5
7. ClickOK.
8. Save the file and add it to your EasyWorship Schedule.

See Using PowerPoint Files



Import PowerPoint Text Into the Database
Save PowerPoint as Outline/RTF file

1. Open your PowerPoint file in PowerPoint.
2. Select File >Save as.
3. In the Save as box, select the Outline/RTF file format at the bottom.
4. Click Save.

Import the RTF Into EasyWorship

1. Open EasyWorship.
2. On the toolbar, click the New Song icon.

3. In the Song Editor next to the song title click the Open Folder icon.
4. Browse to the .rtf file you saved.
5. Select the file and clickOpen.
6. ClickOK on the song to save the song to the database.

Note
l Not all PowerPoint files aremade the same, so thismay not work for all PowerPoint files.
l Youmaywant to select all of the text in the song and click on Reset Attributes to reset the text attributes to default.



How Do I Delete Messages From the Message Alert List?

In the Message Alert window:
1. Click on theMessage drop down box.
2. Use the arrow keys on your keyboard to select themessage you want to remove.
3. Press the delete key on your keyboard.



Using Foldback Alert

EasyWorship allows you to displaymessages to the congregation. You can add, remove, hide, and scroll messages. You
can also set a prioritymessage, and control the order in whichmessages are displayed.

1. Click the Alerts icon on the Live toolbar, the Foldback Alert or pressCTRL+F.
2. The Foldback Alert dialog box appears.

Adding a message:
1. In theMessage box, type or select themessage that you want to display.
2. In the Count box, type or select the number of times that you want to display themessage.
3. Click Add to add themessage to the Current Running Messages list.

l Themessages in the Current Running Messages list are displayed to the congregation in the order that they
appear in the list.

l The arrow to the left of the Count column indicateswhichmessage is currently being displayed.



l TheCount column shows a "countdown" of themessages as they are displayed.
l If you do not want themessages displayed to the congregation, click Hide.
l To display themessages again, click Show.

Removing a message:
1. In the Current Running Messages list, click themessage that you want to remove.
2. Click Remove.

Select a priority message:
1. In the Current Running Messages list, click themessage that you want to display first.
2. Click Select Priority.
l You can alsomanually control the order of themessages as they are being displayed to the congregation using the
Display Next command.

Select the next message:
1. In the Current Running Messages list, click themessage that you want to display next.
2. Click Display Next.

Changing the Foldback Alert options:
1. On the Livemenu click Display Foldback Options.
2. Then click Alerts and Time.
l For more info, see Alerts and Time in the Display Foldback Options section.

Deleting a message from the Message drop down list:
1. Click the drop down list to show the list of messages already entered.
2. Use the arrow keys on the keyboard to select themessage you want to delete.
3. Press the DELETE key on the keyboard.



Using Message Alert

EasyWorship allows you to displaymessages to the congregation. You can add, remove, hide, and scroll messages. You
can also set a prioritymessage, and control the order in whichmessages are displayed.

1. Click the Alerts icon on the Live toolbar, thenMessage Alert or pressCTRL+M.
2. TheMessage Alert dialog box appears.

Adding a message:
1. In theMessage box, type or select themessage that you want to display.
2. In the Count box, type or select the number of times that you want to display themessage.
3. Click Add to add themessage to the Current Running Messages list.

l Themessages in the Current Running Messages list are displayed to the congregation in the order that they
appear in the list.

l The arrow to the left of the Count column indicateswhichmessage is currently being displayed.



l TheCount column shows a "countdown" of themessages as they are displayed.
l If you do not want themessages displayed to the congregation, click Hide.
l To display themessages again, click Show.

Removing a message:
1. In the Current Running Messages list, click themessage that you want to remove.
2. Click Remove.

Select a priority message:
1. In the Current Running Messages list, click themessage that you want to display first.
2. Click Select Priority.
l You can alsomanually control the order of themessages as they are being displayed to the congregation using the
Display Next command.

To select the next message:
1. In the Current Running Messages list, click themessage that you want to display next.
2. Click Display Next.

Changing the message alert options:
1. On the Livemenu clickOptions
2. then click theMessage Alert tab.
l For more options, see Alerts in the Options and Settings section.

Deleting a message from the Message drop down list:
1. Click the drop down list to show the list of messages already entered.
2. Use the arrow keys on the keyboard to select themessage you want to delete.
3. Press the DELETE key on the keyboard.



Using Nursery Alert

EasyWorship allows you to quickly display a number, or set of numbers, which you have assigned to each child in the nurs-
ery. You can alert the parents in the congregation by displaying their child's number in one of the corners of the screen.
This lets a parent know when they are needed in the nursery.

Add or Remove a nursery alert:
1. Click the Alerts icon on the Live toolbar, then Nursery Alert or pressCTRL+N.
2. The Nursery Alert dialog box appears.

3. Enter the parent number or name in the Nursery Number box.
4. Click Add to display the nursery alert.
l Click Remove to take the number off the display.
5. You can typemultiple numbers or names separated with a space. Using a comma separator works, however when

removing thenmessage from the screen you have to click Remove for each number or name.

Notes
To change the nursery alert options, on the Livemenu, clickOptions, and then click Alerts. For more details, see Alerts in
the EasyWorship Options and Settings section.



Understanding Profiles

Profiles consist of both User Settings and Application data. Application Data consists of databases such as songs and
backgrounds, along with videos, images, feeds and DVD clips. User Settings consist of settings like font size, color and
transition settings. It also contains information about the EasyWorship window size and location. Settings like the output
monitor setting are global settings that will affect all users and are not part of the profile settings. Profiles combines the abil-
ity of allowing EasyWorship to store application data in different locationswith the ability to havemultiple sets of user set-
tings for that application data.

The profile data can be stored on the local hard drive, on a server or shared network folder. EasyWorship will create a
Default profile in the following location. Common Documents\Softouch\EasyWorship.

Notes
CommonDocuments Locations ByOperating System:
Windows XP - C:\Documents and Settings\All Users\Shared Documents
Windows Vista & 7 - C:\Users\Public\Public Documents

Possible Configurations of Profiles:
l Use the same set of application data as another profile but different user settings.
l Use a different set of application data with the same user settings as another profile.
l Use a different set of application data and a different set of user settings.

EasyWorship also allows for easy hot swapping between profiles. Thismeans that EasyWorship doesn't have to be
closed when switching from one profile to another.

See Creating Profiles , Locating Your Profile Data and Using Profiles for more information about using profiles.



Creating Profiles

EasyWorship will create a default profile automatically when it is installed. If another set of data or settings is desired, cre-
ating a new profile can accommodate this need.

Creating a New Profile:
1. Open EasyWorship
2. Click on the Profiles menu.
3. Click on Profiles Manager

4. The Profiles Manager screen appears.

5. Click on Create a new application Profile under
Manage application profiles.



6. Type the name of the profile in the Profile Name
area. For Example: Youth, Pastor, Con-
temporary...

Profile Information:
7. Under Create a new application data instance

the default path for the profile data will be dis-
played. Click Browse to select a different location.

l Youmay use another profile's set of data if
you don't want to create a new set of data.
See Using A Shared Database

l The default profile data will be in Shared or
Public Documents \ Softouch \ EasyWor-
ship.

l A new folder for the profile data can be cre-
ated in the default location, another place on
the hard drive, on a server or shared net-
work folder. ClickMake New Folder in the
browse window to create a folder.

Notes
Shared or Public Documents can be located in different locations depending on your operating system. For Windows
XP it will be in My Computer\C:\Documents and Settings\All Users\Shared Documents for Windows Vista it will be
located in Computer\C:\Users\Public\Public Documents.

Application Options:
8. Create a name for options to be used on this pro-

file.
l If Create a new application data instance is selec-
ted, there will be no profile options to select from
the drop down list. EasyWorship will automatically
create an application options name.

l If Use an existing application data instance is
selected, type in the desired name for this profile's
options or select a name from the drop down list.



l To create a new set of application options type the
name for the new options in the "new application
options name" box.

9. Click Save Profile.
10. The new profile will now show up in the profiles list.

Notes
If you want to return to the Profiles Manager after creating the new profile uncheck the option for "Start Using this profile
when complete".



Editing Profiles

To change the settings or folder location of a profile:
1. Open EasyWorship
2. Click on the Profiles menu.
3. Select Profiles Manager.

4. Select the profile to be edited.

5. Click Edit the selected profile

6. The Edit Application Profile window appears.

Profile Information:
l Create a new application data instance.

l Allows you to select another location to store
the application data for this profile.

l Use an existing application data instance.
l Uses the original application data location
assigned when the profile was created.

Application options:
l Type in the name of a new set of options for this pro-
file.

l Allows you to type in the name of a new set
of options for this profile.

l Select another set of options for this profile.
l Allows you to select another set of options
for this profile if another set of options has
been created.





Locating Your Profile Data

Youmay eventually need to transfer your database from one computer to another or copy videos or images into the
resources folder. To find the location of the data for your profile use the following steps.

1. Open EasyWorship.
2. Click on the Profiles menu.
3. Click on Profiles Manager.
4. Select the profile.

5. Click on Edit the Selected Profile at the bottom of the
window.

6. Click in the "Use an existing application data
instance" field, to show the location of the profile on
the hard drive. Use the right arrow key to scroll the text
for viewing the end of the file path.

7. UsingMyComputer or WindowsExplorer Browse to that location on your hard drive to find your data files.

l The databaseswill be stored in a Databases folder in a folder called Data.
l Videos and Imageswill be stored in the Resources folder.
l Options for the profile will be stored in the Options folder.



Using a Shared Database
Profile Information:

1. Open EasyWorship
2. Click on the Profiles menu.
3. Click on Profiles Manager

4. The Profiles Manager screen appears



5. Click on Create a new Application Profile.
6. Type the name of the profile in the Profile Name area. For

Example: Shared, Network...
7. Select Use an existing Application data instance.
8. Click Browse to locate the shared profile folder.

9. For network databases browse to Network or My Network
Places\Computer Name (e.g. WorshipPC)\ SharedDocs or
Public\Softouch\EasyWorship\

10. Select the profile folder (e.g. Default).
11. ClickOK



Profile Options:
12. Type in the name you want to use for this profile's options or

select a name from the drop down list.
13. Click Save Profile.
14. The profile you created will now show up in the profiles list.

Notes
If you want to return to the ProfilesManager after creating the new profile. uncheck, the option for "Start Using this profile
when complete".



Using Profiles

Changing Profiles:

EasyWorship allows you to change profiles giving you the ability to use different databases and settings.

Switching from one profile to another is easy.

1. Click on the Profiles menu.
2. Select the profile you want to use.
3. EasyWorship will load that profile.

If you have a schedule open, EasyWorship will ask you to close it before loading the selected profile.

Determining which profile is currently loaded is also easy. The current profile is displayed in the title bar at the top left of the
window.



Recommended Presenter Remotes
Most EasyWorship customers are familiar with using a presenter remote for advancing slides in PowerPoint slide shows.
Many remote controls purchased for this purpose use hard coded keyboard Hotkey combinations that work with Power-
Point. EasyWorship requires different Hotkey combinations than PowerPoint. A programmable presenter remote is the
best solution for use with EasyWorship. Below is a list of remote controls that allow the buttons to be programmed tomatch
the Hotkeys for EasyWorship. See EasyWorship Hotkeys for a list of EasyWorship hotkeys.

Recommended Presenter Remotes:

Interlink Remotes:
(http://www.smklink.com/presentation_remotes/index.html)

VP4450 - RemotePoint Emerald Navigator (Get Key Programming Utility Here)

VP4300 - RemotePoint Presenter Special Edition

VP4810 - RemotePoint RF (Get Drivers Here)

VP4910 - RemotePoint Jade (Get Key Programming Utility Here)

Notes
l All of the Interlink wireless presenters listed here have four programmable buttons.
l The bottom of the wheel on the emerald is an unmarked programmable button
l  Software for the VP4300 is not available for download. All other utilities are available via the Interlink Download
Center.

http://www.smklink.com/presentation_remotes/index.html
http://www.smklink.com/library/media/other/IEdeploy.zip
http://www.smklink.com/support/downloads.html
http://www.smklink.com/library/media/other/IEdeploy.zip
http://www.smklink.com/support/downloads.html
http://www.smklink.com/support/downloads.html


Honeywell Remotes:
(www.powerremote.com)

PowerPresenter RF See: Changing the Remote Key Strokes in theManual
PowerPresenter Plus(Includes 128mb Flashmemory) See How to Change the Remote Key Strokes in

theManual

Notes
l This remote requires no software to program.
l It has two programmable buttons and allows for three functions. Each button has its own command. Pressing both
buttons allows for a third command. It also includes another button for a laser pointer.

Can I use a remote that can't be programmed?
Yes, some non-programmable remoteswill work. Changing the hotkeys in EasyWorship is required. See Using a Non -
Programmable Presenter Remote

http://www.powerremote.com/
http://www.powerremote.com/pdf/PPRF_4J.pdf
http://www.powerremote.com/pdf/PPRFPLUS_4J.pdf


Using a Non-Programmable Wireless Presenter

Most wireless presenters are programmed to emulate keyboard key combinations that trigger functions in PowerPoint. If
the key combinations can't be changed, EasyWorship's Hotkeys have to be changed tomatch the key combinations used
on the presenter you have.

Click here to visit our online Knowledge Base article about Non-programmable Presenter Remotes for more information.
(Requires an internet connection to view)

See Changing EasyWorship Hotkeys

http://www.easyworship.com/support/kb/index.php?ToDo=view&questId=100&catId=3
http://www.easyworship.com/support/kb/index.php?ToDo=view&questId=100&catId=3


Adding Notes In A Song

Notes can easily be added to a song. Use the instructions below to add notes to a song.

1. Edit or create a new song.
2. Enter an open parenthesis after any song tags.
3. Enter the text to be displayed as a note.
4. Enter a closed parenthesis at the end of the note.



Adding a Blank Slide To a Song

A blank slide can easily be added to a song. Use the instructions below to add a blank slide to a song.

1. Right-click in the place where you want the slide.
2. Select the slide song tag.
3. Press ENTER.

There will now be a blank slide in the song.



Changing EasyWorship Hotkeys

1. Browse to the following path.
Windows 9x / ME: C:\WINDOWS\All Users\Application Data\Softouch\EasyWorship\SEttings\hotkeys.ini
Windows 2000 / XP: C:\Documents and Settings\All Users\Application Data\Softouch\EasyWor-
ship\Settings\hotkeys.ini
Windows Vista / 7: C:\ProgramData\Softouch\EasyWorship\Settings\hotkeys.ini

2. Double-click the HotKeys.ini file to open it.

It will open in Notepad allowing you tomake changes.

3. Make the following changes, adding the numbers in bold tomake EasyWorshipmatch your non-programmable
presenter remote.

Next Slide - SlideNextKeys= 78, 40, 32, 34
Previous Slide - SlidePrevKeys= 80, 38, 8, 33
Black Screen - BlackScreenKeys= C-66, 66
GoLive - GoLiveNextKeys= 0
Go ToBridge - JumpBridgeKeys= 0

Notes This will disable the following hotkeys in EasyWorship.
PageDown = Go Live
PageUp=Go Live Previous (Currently not active in EasyWorship)
B = Jump to bridge

Notes This will also setup the following PowerPoint HotKeys to work in EasyWorship.
PageDown = Next Slide
PageUp = Previous Slide



B = Black Screen

4. After making changes, click File then Save.
5. Close the window.

l Youwill need to know what each value is. Each item can havemultiple keys separated by comas; for example,
SlideNextKeys = "78, 40, 32" which is 'N', Down Arrow, and Space.

l If you want to use the CTRL or ALT, key simply precede the number with 'C-', or 'A-' or 'CA-' for both CTRL and ALT
together; for example, BlackScreenKeys = "C-66" which is CTRL-B.

Here is a list of keys:
Commonly Used
Keys:
B = 66
C = 67
N = 78
P = 80
BackSpace = 8
LeftArrow = 37
UpArrow = 38
RightArrow = 39
DownArrow = 40
SpaceBar = 32
PGUP = 33
PGDN = 34
End = 35
Home = 36
.(Period) = 190
Escape(ESC) = 27

Alphabet
A - Z = 65 -90
A=65
B=66
C=67
D=68
E=69
F=70
G=71
H=72
I=73
J=74
K=75
L=76
M=77
N=78
O=79

P=80
Q=81
R=82
S=83
T=84
U=85
V=86
W=87
X=88
Y=89
Z=90

SeeWhat HotKeys are available in EasyWorship?



Creating Congregational Prompts

1. Edit or create a new song.
2. Select all of the text in the song and set the text size, e.g. 30%.
3. In the Song Editor press SHIFT+ENTER to create spacing between the song text and the prompt.
4. Type in the prompt, e.g., a prompt for offertory.
5. Select the prompt text and set lower the size of it. Use the up and down arrow buttons next to the font size to

increase or decrease the font size.
6. Copy and paste the prompt onto the slides you wish to use it on.
7. Select the prompt text and set the color you wish to use.
8. ClickOK.

Notes
If you don't want these changes to be permanent, make the changes to the song in the schedule and not the database.
Font sizing can be different for each computer depending on the screen resolution being used for the output screen. Use a
custom position that matches the output screen at your church, and the text will always show up the same.



Organizing Images and Videos

To organize images and videos in folders:
1. Browse to Your Profile > Resources > Videos or Images. See Locating Your Profile Data
2. Create any folders you would like to create.
3. Copy your images or videos into any of the folders you would like.
4. In the Resource Area, click theMedia tab.
5. Click on the Images or Videos tab.

6. Click on the folders button at the top right.
7. Select the folders of images or videos you wish to display as thumbnails in the videos palette, and clickOK.

8. Thumbnails for the data in that folder appear in theMedia area.

Notes
If you add images or videoswhen displaying a folder, it will cause the image or video you added to be added to the folder
you are currently viewing. 



Playing Flash Content

To play SWF files. See Playing Flash Content
For playing FLV files install the K-Lite codec pack.

http://www.easyworship.com/support/kb/index.php?ToDo=view&questId=80&catId=9


Playing Quicktime Files In EasyWorship

Natively, EasyWorship andWindows don't support Quicktime files. However, with the proper video codecs installed,
EasyWorship will playmost Quicktime files. This Codec packwill allow you to playMp4, H.264 andmost Mov files along
with FLV files.
See Installing the K-Lite Codec Pack on the online Knowledge Base.

http://www.easyworship.com/support/kb/index.php?ToDo=view&questId=80&catId=9
http://www.easyworship.com/support/kb/


Running EasyWorship in Single Monitor Mode

If the computer being used for EasyWorship doesn't have dualmonitor capability, it is best to purchase and install a video
card that supports dualmonitor capability.
See Computer Requirements Video Card for more information on the best type of video card to purchase.
See DualMonitors Explained for more information about how dualmonitors work.

EasyWorship can run in singlemonitor mode although it is not recommended, nor designed for this purpose.

Working in Single Monitor Mode:
1. After clicking Go Live with the presentation, hold the CTRL + SPACE BAR and the working screen will dis-

appear, leaving only the output screen.
2. Navigate using the EasyWorship Hotkeys on the keyboard.
l Use the Arrow Down key to advance the next verse or slide of a song.
l Use Page Down key to advance the next item in the schedule.
l Use Left Arrow Key to select the previous item in the schedule.
l Use ESC or CTRL + SPACE BAR to bring the working screen back and discontinue the live output of the working
screen.

SeeWhat Hotkeys are available in EasyWorship? for amore extensive list of Hotkeys.



Using Custom Position

Here are a couple of reasons to use the custom position.
l Building services at home so that the displaymatches the presentation computer.
l Using the Foldback feature with theMatroxDualHead2Go.

Building Services At Home:

If a schedule is built on a computer using a different output resolution than the presentation computer, the songswill not dis-
play correctly on the presentation computer. Setting a custom resolution on the source computer will correct this problem.

On the Presentation Computer
Determine the output screen size of the presentation computer.

1. Open display settings on the presentation computer.
2. Click on the secondmonitor.
3. The resolution for that screen will be displayed there. e.g.

1024x768.

On the Home Computer
1. Open EasyWorship on your home computer.
2. Click on theOptions button on the toolbar.
3. Under General, Select Output Monitor, changeOutput

Monitor to Custom Position.
4. Change theWidth and Height to match the presentation

computer.
5. ClickOK.

Using Foldback:
See FoldbackMonitor Setup



How Do I Add Videos To the Background Palette?

Adding Video to the Background Palette:
See Adding Backgrounds



How Do I Edit Scriptures?

SeeUsing ScripturesUnder Scriptures.



How Do I Use the Schedule?

SeeUsing the Schedule



How Do Videos, Images & Backgrounds Work?

Images & Videos
EasyWorship reads the resources folder in your profile to display the thumbnails for images and videos. The files aren't
stored in a database. Only the thumbnails are in a database.When you add videos and images to theMedia tab from
another location on your hard drive, such asMyDocuments, EasyWorship will create a shortcut to the video or image in
your profile Resources folder.

If you delete the video from its original location (MyDocuments), an exclamation point will appear on the thumbnail for that
video or image. The exclamation point means that EasyWorship can't find the file.

If you add a video or image to themedia area from an external disk like a CD or memory stick, EasyWorship will copy the
actual file to the Resources folder in your profile.

When adding images or videos, youmaymanually copy your files directly to the video or images folder in Resources folder
located in Your Profile. This is the preferredmethod. This way you keep all of your images and videos in the same place. In
the event that you want to transfer all of your backgrounds and songs from one computer to another, all you would have to
transfer is the data folder and the Resources folder.

See Locating Your Profile Data to find out how to located your resources folder.

Backgrounds
Backgroundswork differently than the images and videos tabs. Backgrounds is an actual database of links to the files you
have added to your Backgrounds palette. It also contains thumbnails of those images or videos. The actual videos and
images aren't in the database.When you add an image or video to the Background palette, EasyWorship creates an entry
in the database telling it where to look for that file with an attached thumbnail for that file. This is whywe recommend keep-
ing all videos and images in the Resources folder mentioned above.

If you add a video or image to themedia area from an external disk like a CD or memory stick, EasyWorship will not copy
the actual file to the database. It will only create a link to the external drive. When you take that disk out or disconnect the
drive, an exclamation point will appear on the thumbnail for that background. The exclamation point means that EasyWor-
ship can't find the file.



What HotKeys Are Available In EasyWorship?

See EasyWorship Hotkeys



Where Is the Manual That Comes With EasyWorship?

EasyWorship has a DocumentationManual available under the Documentation folder on your EasyWorship CD. It can be
accessed from the install menu that appears when you insert the CD into your drive. Youmay also download themost
recent version from our web site.

http://www.easyworship.com/downloads/EasyWorshipManual.pdf


Adding and Removing Demo Data

Youmay have said no to this option during installation. At any time youmay add or remove these song lyrics from your
song database.

1. Select Profiles > Database tools > Add/Remove Demo Data

3. The Add/Remove Demo Data window will appear.

Adding Demo Data:

1. To install the 100+ classic and contemporary songs fromGreatWorshipSongs.com, Select "Install songs from
GreatWorshipSongs.com now"

2. Click Next.

l The same process applies for removing these songs from your song database

l You now have the option to add the songs and backgrounds fromEasyWorship. This will install public domain songs
like AmazingGrace and the free images and videos that comewith EasyWorship ( about 116 images, 21 videos and
223 songs ).

http://www.greatworshipsongs.com/


6. To install the default backgrounds and songs fromEasyWorship, select "Install default songs and backgrounds
from EasyWorship"

7. Click Next.

l Now awindow will appear giving you the summary of your song database choices.

8. Click Finish to proceed with installation of the EasyWorship demo data or click Back to change your
previous selections or.

Remove Demo Data:



1. Selec Profiles > Database tools > Add/Remove
Demo Data

3. The Add/Remove Demo Data window will
appear.

4. Select Uninstall songs from GreatWor-
shipSongs.com.

5. Click Next.
6. Then select Uninstall Default songs and back-

grounds from EasyWorship.
l This feature also removes the backgrounds
installed with EasyWorship.

l This featuremay not be available if you
upgraded from a previous version of
EasyWorship.

7. Click Finish.

Notes
Removing the demo data will not remove any songs or backgrounds that have beenmodified or added to the database.



Databases and Profile Backup

It's a good idea tomake a backup of your database. You can also use the backup tomove songs, scriptures, and present-
ations from one computer to another.

1. Locate your profile folder. See Locating Your Profile Data
2. Right-click on the profile folder you wish to backup.
3. Select Send To, then select thememory stick or CD drive that you want to backup to.

l Youmay also copy and paste the profile folder to any location you wish.

Notes
l Inside the Profile folder

l The databaseswill be stored in a databases folder in a folder called "Data."
l Videos and imageswill be stored in the Resources folder.
l Options for the profile will be stored in the Options folder.

l Default locations for profile folders:
l Windows XP users browse to: MyComputer/ C: Drive/ Documents and Settings/ All Users/ Shared Docu-
ments/ Softouch/ EasyWorship/

l Windows Vista / 7 users browse to: Computer/ C: Drive/ Users/ Public/ Public Documents/ Softouch/
EasyWorship/



Transferring the EasyWorship Database To Another Computer
Step 1
Determine Which Profile Folder EasyWorship is using on the Source (old) computer.
Open EasyWorship on the source (old) computer.

1. Click the Profiles menu.
2. Click Profiles Manager.
3. Select the profile you wish to transfer. (Youmay only have Default listed here)
4. From the links at the bottom of the window, click the option to Edit the selected application profile.
5. Click in the Use an existing application data instance field, to show the location of the profile on the hard drive.
6. Use the right arrow key to scroll the text for viewing the end of the file path. The Profile folder is the last folder in the

path.
Example: Softouch/EasyWorship/Default/
* Default is the profile folder that you need to back up in this case.

7. Write this information down for use in Step 2.
8. Close the EasyWorship program.

Step 2
Backup the Profile Data.

1. Browse to the following location:
Windows Vista / 7
Computer / C: Drive / Users / Public / Public Documents / Softouch / EasyWorship / Profile folder from Step 1

Windows XP / 2000
MyComputer / C: Drive / Documents and Settings / All Users / Shared Documents / Softouch / EasyWorship / Pro-
file folder from Step 1

2. Inside the profile folder you will find Databases, Options and Resources.
3. Right-click each folder, select send to, then select your memory stick (flash drive).
4. After the folders have finished transferring to thememory stick, unplug it and proceed to Step 3.

Step 3
Restore the profile data.

1. Plug thememory stick into the destination (New) computer.
2. Open Computer (MyComputer), then double-click on the drive for thememory stick.
3. Select the Databases, Options and Resources folders. (hold down the CTRL key on your keyboard and click the

folders to select multiple)
4. PressCTRL+C to copy the folders. (You will not see anything happen, thismakes it possible to paste the folders

later)
5. Browse to the appropriate location for the Operating System you are using.

Windows Vista / 7
Computer / C: Drive / Users / Public / Public Documents / Softouch / EasyWorship

Windows XP / 2000
MyComputer / C: Drive / Documents and Settings / All Users / Shared Documents / Softouch / EasyWorship



6. Right-click the Default folder or the folder that EasyWorship is using on this computer.
If there ismore than one profile folder in the EasyWorship folder, youmay need to go through the steps in Step 1 to
determine which profile folder EasyWorship is using on this computer.

7. Click paste.
8. If asked to overwrite or merge folders, allow it to do so. This will replace the database on the destination (new)

computer.
9. The database transfer is now complete.

SeeTransferring The EasyWorship Database To Another Computer on the online Knowledge Base.

http://www.easyworship.com/support/kb/index.php?ToDo=view&questId=104&catId=14


Using Command Line Switches

EasyWorship now allows you to assign values to the EasyWorship shortcut to change the behavior of the programwhen it
opens. These values are called command line switches.

Available Command Line Switches:

o ProfileName="a_profile_name" (start EasyWorship with a selected profile)
o /RebuildDatabase (force the database to rebuild and then rebuild the SongKeys)
o /RebuildSongKeys (force EasyWorship to rebuild SongKeys)
o /ConvertDatabase (force EasyWorship tomake sure the database is up to date)
o /ResolveShortcuts (force EasyWorship tomake sure it's internalmedia shortcuts are resolved if possible)

Setting a Command Line Switch:

1. Right-click on the EasyWorship icon on the Desktop.
2. Click Properties.
3. Click on the shortcut tab.
4. In the Target field after the last quotationmark type a space using the space bar key.
5. Type in the command line switch you desire to use after the space.
6. ClickOK to apply and save the settings.

Notes
Command line switches are designed for advanced users. If you have any problemswith or questions regarding com-
mand line switches, please contact support at support@easyworship.com.

mailto:support@easyworship.com


Using the Rebuild Database Utility

EasyWorship has a utility to correct database problems. Youmay lose the song you were inputting at the time, but will
retain all your other songs and graphics.

Rebuild Database Utility:
1. Click the Start icon.
2. Select Programs or All Programs.
3. Select EasyWorship.
4. Select Rebuild EasyWorship Database.
5. The EasyWorship Splash Screen will appear with a progress bar at the bottom right.
6. When the rebuild is complete, EasyWorship will open.

Notes
The Rebuild Database feature will automatically backup your database into a folder called rebuild backup.

This usually fixes any database error messages. However, if you still have a problem, check our knowledge based tech-
nical support at http://www.easyworship.com.

The link info is: http://www.easyworship.com/support/kb

Or call technical support for any other error messages +1-918-250-1493.

http://www.easyworship.com/
http://www.easyworship.com/support/kb/


ActiveMovie Window Appears Over My DVD Editor

SeeDVD Plays on Both Screens for instructions on correcting this issue. A video codec can also cause this problem.
See RecommendedDVD &Mpg2Decoders for info on what codecs should be used.



Audio Pauses During Transition

Some customers that useMedia Player to play audio while using EasyWorship to display lyrics, have seen this issue. Dur-
ing the transition from slide to slide or song to song, themusic pauses. This problem can be corrected easily.

1. Click on the Live menu.
2. Click onOptions.
3. Click onAdvanced.
4. Slide theVideo Quality slider to themiddle of the Speed - Quality bar.
5. ClickOK.



Borland Database Engine Error $2108

An error occurred while attempting to initialize the Borland Database Engine (error $2108 )
1. Browse to C:\ProgramFiles\Common Files\, in myComputer or WindowsExplorer.
2. Rename theBorland Shared folder toBorland Shared old.
3. Click onStart.
4. Click on run.
5. Type in regedit in the Run box.
6. ClickOK.
7. Browse to go toHKEY_LOCAL_MACHINE\SOFTWARE\.
8. Rename theBorland folder toBorland Old.
9. Close the registry editor.
10. Reinstall EasyWorship.



Borland Database Engine Error $251E

An error occurred while attempting to initialize the Borland Database Engine (error $251E )
1. Browse toC:\Program Files\Softouch\EasyWorship, in MyComputer or WindowsExplorer.
2. Right-click on theEasyWorship.exe file.
3. Click on properties.
4. Click on theCompatibility tab.
5. Make sure the compatibilitymode box is not checked.
6. ClickOK.

If an EasyWorship upgrade has been installed without installing a full version first, installing the full versionmay fix this prob-
lem.



DVD Plays on Both Screens

The video card is set up to play the video on bothmonitors.
Disabling the full screen options on your video card will correct this problem.

nVidia cards:
1. ClickStart.
2. ClickControl Panel.
3. Click onDisplay.
4. Click on theSettings tab.
5. ClickAdvanced.
6. Click on theGeForce Tab

A boxwill appear the left of the window.
l If Launch Page andControl Panel User Interface appear in the box follow the instructions below.

If not skip to step 7.
1. Click onControl Panel User Interface.
2. SelectClassic NVIDIA Control Panel.
3. ClickApply.
4. Go to step 7.



7. Click on Full Screen Video.
8. Select disable under Full screen device.
9. ClickOK.

ATI Cards:
1. Click theStart button.
2. OpenControl Panel.
3. Open theCatalyst Control Panel.
4. Go toVideo, Theater Mode.
5. SelectMain Display.
6. Change theOverlay Display Setting toStandard.
7. ClickApply thenDone.





Exclamation Points On My Thumbnails

This error appears when EasyWorship cannot link the thumbnail in your Videos Resource Area to the actual location of
the video. Thismay be caused when you delete, rename or move the video or image file.

See How do Videos, Images & BackgroundsWork?

To remove the exclamation points:
1. Open EasyWorship.
2. Click on theMedia tab in theResources Area.
3. Click on theVideos or Images tab.
4. Select the thumbnail with the exclamation point
5. Click theDelete button below.
6. If you wish to re-add that same video or image file thumbnail, click theAdd button.

Please get in the habit of storing videos and images in this location: Your Profile\Resources\Videos or Images
See Locating Your Profile Data for help finding your EasyWorship profile data.
Adding your videos and images to the videos or images folder will make the videos or images automatically show up in
EasyWorship without having to add them using the add button. See Send To Shortcut for CopyingMedia

7. Click in the Look In field and follow the above path to locate and store your videos. When you highlight the video file
and clickOpen, the thumbnail will now be added to theVideo Resource Area. Open EasyWorship again and see if
this fixes your error.

Notes
Anytime you add videos from the Videos Resource Area, for example, from aWorship Films videos volumeCD, the file is
stored in Your Profile\Resources\Videos. This is the default path to which EasyWorship auto formats. That is why it is a
good idea to store files constantly in this path. See Locating Your Profile Data for help finding your EasyWorship profile
data.



'Index: Title Author'  Error

If you receive the Index Title Author Error message, follow these steps:

1. Close EasyWorship.
2. Right-click the EasyWorship icon on the Desktop.
3. Click on the shortcut tab.
4. In the Target field add after the last quote press the space bar then type in /convertdatabase.
5. ClickOK.
6. Open EasyWorship.
7. The database will convert and EasyWorship will open.
8. Remove the /convertdatabase switch from the target filed of the shortcut.



Internet Connectivity

EasyWorship doesn't require an internet connection for you to use it. However, there are some functions that require an
internet connection. Here are some issues that may occur when using these features.

Issue: Action Canceled or You are not Authorizedmessage appears when trying to access the tabs in the Online Area.
Cause: Your internet connection is limited or disconnected. Youmay have a firewall blocking EasyWorship's access to the
internet.
Resolution: Make sure you can access the internet through an internet browser. Make sure your firewall software hasn't
added EasyWorship to a block list.

Issue: Unable to get available biblesmessage appears when trying to download bibles.
Cause: Your internet connection is limited or disconnected. Youmay have a firewall blocking EasyWorship's access to the
internet.
Resolution: Make sure you can access the internet through an internet browser. Make sure your firewall software hasn't
added EasyWorship to a block list.

Contact Customer Support if your problem cannot be resolved by following the steps above.



No Sound

When playing video clips or audio files through EasyWorship, sound should come from either the speakers connected to
the computer or the sound system already in place in the building. Please check the following if you are unable to hear
sound from audio sources in EasyWorship.

Check the Mute Button in EasyWorship

When playing a video or audio file in EasyWorship the VCR controls will appear in the Preview Area and or the Live Area.
The audio can bemuted and un-muted there by pressing the speaker icon.

Check Cables and Connections

The connection to the computer's audio output jackmust be connected. Verify that the computer is plugged into the speak-
ers or sound board. Also, check the audio cable to the sound equipment for any kind of damage.

Check the Sound Board Mute Button and Volume

Many customers connect their computer to a sound board that controls the audio to the sound system. Verify that the chan-
nel on the sound board for the computer is not muted and the fader for the audio is at an appropriate level. Also, verify that
themaster volume is at an appropriate level.



'Path Not Found' C:\...\Temp... Error

If you receive this error follow the instructions below:

1. Close EasyWorship.
2. Open EasyWorship.
3. Close it again.  
4. Reopen it again.

The error should be corrected.

Notes
This process clears out all of the temp files for the schedules. Sometimes EasyWorship will try to access an old temp file
that has already been removed. This resets the temp folder so it won't try to access the file again.



PowerPoint Troubleshooting

Issue: PowerPoint slide show with audio doesn't play the audio in EasyWorship.
Cause: PowerPoint isn't able to find the audio file.
Resolution: First, make sure the audio file is on the computer's hard drive, preferably in the same folder as the PowerPoint
file. Open the PowerPoint file in the PowerPoint program, then run the slide show so that it can find the audio files. Save
the PowerPoint file and close PowerPoint. It should now play the audio in EasyWorship.

Issue: EasyWorship is unable to add a PowerPoint slide show to your schedule. A message appears saying the file is cor-
rupt.
Cause: Usually, this is caused by editing a PowerPoint file that has been created on a newer version of PowerPoint with
an older version of PowerPoint.
Resolution: Import the original PowerPoint file.

Issue: Out of memory error when adding a PowerPoint to your schedule, or when opening a schedule with a PowerPoint
file in it.
Cause: The schedule file has corrupted, or the PowerPoint file is too large.
Resolution: Recreate the schedule. Try reducing the size of the PowerPoint file before adding to your schedule.

Issue: PowerPoint doesn't display correctly
Resolution: Click on the Livemenu, clickOptions, then theMisc tab. Try toggling the Use PowerPoint application instead
of viewer off or on.

Issue: Thumbnails don't display properly.
Resolution: Click on the Livemenu, clickOptions, then theMisc tab. Try toggling the Build Thumbnails with PowerPoint
Application instead of viewer off or on.

Contact Customer Support if your problem cannot be resolved by following the steps above, or visit www.easy-
worship.com/support.

http://www.easyworship.com/support/kb
http://www.easyworship.com/support/kb


PSAPI.DLL Error

The procedure entry point GetProcessImageFileNameW could not be located in the dynamic link library
PSAPI.DLL.

First, read the information on thisMicrosoft Help Article. http://support.microsoft.com/default.aspx/kb/932540
This problem usually occurs after upgrading to Internet Explorer 7. This error occurs when clicking the Songsmenu, then
SongSelect Lyric Service.

1. Click on theStart button.
2. Click onSearch.
3. Select the option to search for all files and folders.
4. Type inPSAPI.DLL
5. Click theSearch button.
6. Rename all instances of PSAPI.DLL.
7. Restart Wndows.

Notes
Be sure not to delete or rename any other files with the PSAPI.DLL in the file name. Rename only the files with
PSAPI.DLL as the exact file name .

http://support.microsoft.com/default.aspx/kb/932540


My Schedule Won't Save

This usually occurs with a song that had a background added in the database and the background has been removed from
the hard drive. The song is still referencing the image or video. When EasyWorship tries to save the schedule, it's unable
to do so because it can't find one of the images or videos to add it to the schedule. Follow the instructions below to correct
this problem.

1. Click on theSchedulemenu.
2. Click onCheck schedule for errors.
3. EasyWorship will display anUnresolved schedule itemswindow.
4. SelectRemove - Delete all schedule items or properties that cannot be resolved.
5. ClickFinish.



Song Editor Loads Slowly

Some customers have experienced slow response when creating a new song, editing a song, opening options or opening
the background designer. A large font database in theWindowsOperating Systemwill cause this slow response.
EasyWorship has to load all of the fonts in theWindows fonts database when opening these windows. Having thousands
of fonts in theWindows font database can cause these windows to load slowly. Removing some of the fonts in theWin-
dows font database will correct this problem.



Text Over Video Troubleshooting

Issue: My video shows up as a still image when I set it as a background.
Cause: DirectX is not enabled.
Resolution: Click on help, DirectX troubleshooting. A message will appear "You do not have DirectX enabled.Would you
like to try to enable it now?" Click Yes to enable DirectX.

Issue: Only part of the text appears over the video background.
Cause: You do not have enough videomemory to display text over video.
Resolution: Upgrade your video card to a video card with 128mb video ram. Youmay also try reducing the color quality for
one, or both of your monitors under your video settings inWindows.

Issue: The video speeds up and slows downwhen transitioning from one song or slide to the next.
Cause: Your video codec isn't handling the video properly.
Resolution: Try downloading a new video codec such asDScaler. See RecommendedDVD &Mpg2Decoders

Contact Customer Support if your problem cannot be resolved by following the steps above.



Transitions Flicker
This is an issue that only occurs with NVIDIA 6, 7 and 8 series graphics cards using the latest drivers onWindowsVista.

To resolve this issue, change the theme inWindows to the Classic Theme. Or change the screen resolution on both
screens to the same resolution.

To change the theme:

1. Right-click on theWindowsDesktop.
2. Click Personalize.
3. Click on the Theme.
4. Change the theme to Classic.
5. ClickOK.

To change the screen resolution on both monitors:

1. Right-click on theWindowsDesktop.
2. Click Personalize.
3. Click on Display Settings.
4. Click onMonitor 1 and set the resolution to the same resolution asMonitor 2. (1024x768 or lower is recommended

for Monitor 2)
5. ClickOK.



Troubleshooting Images

Issue: I can seemy image in the image tab, but EasyWorship will not allow me to add it to my schedule.
Cause: The image resolution is too large.
Resolution: Edit the image using an image editing software such asMicrosoft Office PictureManager to resize the image
to 800x600 or 1024x768. You are not limited to these resolutions; however, they are themost common resolutions used.

Issue: My image is stretched.
Cause: EasyWorship automatically stretches your image to fit the screen. If it is not the same resolution as the screen,
EasyWorship will stretch it.
Resolution: Use an image editor such as paint to increase the size of the picture. Youmay also add the image to a Power-
Point slide show. You can tell EasyWorship to tile the picture under Background > Options > select the picture and click
Modify. Check the box to Tile Picture.

Contact Customer Support if your problem cannot be resolved by following the steps above.



Unable to Create Back Surface Error Message

This error usually appears when there are issueswith thememory insufficiency in your video graphics card. Youmay also
have your color quality settings set too low. Many times it is fixable. However, the video cardmay need to be upgraded.

See:Computer Requirements under Computer Requirements to see if your computer meets the requirements to use the
DirectX functionality of EasyWorship.

Follow these steps to adjust your video setting for a possible solution:

1. Close EasyWorship.
2. Right-click on theWindowsDesktop.
3. Click on: XP: Properties, Vista: Personalize, 7: Screen Resolution
3. Click the Settings Tab or the Display Settings Link.

6. Click onMonitor 2.
7. In the Color Quality area, verify that the color quality isn't 8bit. If it is, change the color quality to Highest (32bit).



8. Click Apply. You will be asked if you wish to keep these settings. Click Yes.
9. Close out all these windows and open EasyWorship again and see if this will fix your error.

If the steps above don't fix your error:
Make sure your computer has at least 64MB of video ram.

1. Follow steps 1-5 above.
2. Select Monitor 2.
3. Click the Advanced button at the bottom right.
4. Click the Adapter tab.

l If theMemory Size or Dedicated VideoMemory is less than 64MB, you will have to upgrade your video card.
l If theMemory Size or Dedicated VideoMemory is N/A, your video card isn't reporting the amount of memory avail-
able for the secondmonitor. You will probably need to upgrade the video card in your computer. Contact tech sup-
port before upgrading your video card.



DVD Problems

See Troubleshooting DVD Issues
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